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User Manual

This user manual is part of the available documentation of the Battery Manager software. It is
delivered as a printable PDF document and also as help system to be used directly from the
software. It contains pieces of information required for the use of the described software. You can
find detailed pieces of information about the installation of the software in the installation manual.

Most sections of this manual contain information for all available editions of the software. Special
instructions for the various editions are either highlighted directly in the text or by appropriate
symbols (see the symbols below).

If you find an error or just want to give feedback or suggestions concerning this documentation,
please send an e-mail to:

Leisenfels on the Internet

If you have questions or if you need additional assistance, please visit our Internet server
www.leisenfels.com which is available around the clock. Current versions of the software and
documentation are available for download here.

Used Symbols

Important instruction that should be followed

Additional instructions which can be helpful

Special instruction for the Personal Edition

Special instruction for the Professional Edition

Special instruction for the Enterprise Edition
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Main Window

The main window of the Battery Manager software is divided into main menu (1), tool bar (2),
docking windows (3) and status bar (4).

Main Menu

The main menu (a.k.a. the menu bar) you can find on top as usual. Here the keyboard shortcuts
are implemented allowing the program functions to be activated more quickly. The main menu
consists of the following areas which are explained in detail by the "Main Menu and
Components" section:

• File: Open files in document editor, call the wizards

• Edit: Functions of the clipboard, delete and searching

• Setup: Language, look & feel, font size, and miscellaneous preferences

• Devices: Management of device like chargers or barcode readers

• Database: Management of the accessed databases

• Table: Control of lists displayed by the session window

• Network: Manage connections, open network sessions
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• Window: Docking windows, screen shots, general window functions

• Help: Help system, manual, release notes, status report, license registration

Some of the mentioned functions are supported exclusively by the Professional Edition

or the Enterprise Edition. Please visit our Internet website to read more about the
functions of the available editions.

Tool Bar

The tool bar is located directly below the main menu and holds the most important symbols of
the main menu for a faster access. Here you can find the file functions (File menu), the
clipboard functions (Edit menu), the preferences (Setup menu), the database functions
(Database menu), the network connection management (Network menu) as well as the
window management (Window menu) and the help system (Help menu).

In addition to the symbols the tool bar can be configured the way, that the associated labels
under the symbols are being displayed. You can find a detailed description of the tool bar
functions in the section "Main Menu and Components".

Docking Windows

The docking windows are the central components of the Battery Manager software. Here you
will find all the important functions such as displaying datasets for batteries and manufacturers
as well as the special functions like program messages (logs) and results. The windows will
each be represented by small icons that are integrated in the dock. Possible window positions
are on top, left, right, and bottom. The docking windows are structurally designed for either
horizontal or vertical use, a move from left to right or from bottom to top etc. is possible.

The docking windows can either be attached to the dock as shown above or can be displayed
as separate windows. This is useful, for example, in order to deploy standalone windows such
as the devicewindow in an optimal way. Currently, the following docking windows are delivered
with the Battery Manager software, which are described in section "Docking Windows" in detail:

• File System Window: Navigator for the local file system of the PC

• Session Window: Display of datasets from the connected databases

• Network File System Window: Navigator for remote network file systems

• Document Window: Editors/viewers for texts, binary, and graphics files

• Search Window: Find files/directories based on their names

• Filter Window: Filters datasets by single or multiple field values

• Device Window: Display of charging devices, barcode readers etc.

• Output Window: Program messages (logs)

• Task Window: Tasks which are executed or have been executed by the program

Battery Manager 1.6.3 User Manual - Main Window

6 / 130



• Search Results Window: Matching files/directories

• Update Log Window: Results of database updates

Status Bar

The status bar at the bottom of the main window is used by program to output important
messages for the user. The area to the right contains other components such as to indicate the
state of the clipboard (whether texts, files etc. have been copied) and to show the progress of
ongoing tasks. Far right, the time of the PC clock is being displayed. Some components of the
status bar can also be hidden, also the status bar can be hidden completely in order to save
place in favor of other components.

For detailed information on how to configure the status bar see section "Main Menu and
Components".

Additional Links

• Preferences

Editions

In order to provide all customers with an appropriate and inexpensive program version the
Battery Manager software is currently published in three editions:

• Personal Edition (PE)
• Professional Edition (PRO)
• Enterprise Edition (EE)

Personal Edition (PE)

The Battery Manager Personal Edition (PE) is the smallest and cost-effective solution for all
users searching for a single tool to manage batteries and charging devices and do not need
functions like external server databases or network connections.

The embedded database requires zero administration, the initial configuration may be done
using convenient wizards identifying connected devices and preparing the database quickly.
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The most important features of the Personal Edition are as follows:

• Convenient management of devices, batteries, manufacturers, locations, and measurements

• Supports the embedded database (single-client, single-user)

• RS-232 support for Windows 32/64, Mac OS X, Linux/UNIX

• Auto-logging of charging data and device raw data

• Preinstalled lists of recent battery types and manufacturers

• Backup and restore the database contents (same database)

• Runs on Windows, Mac OS X, Linux, and many more systems

• Use the installers or execute directly with Java Web Start

Please visit our website to read more about the features of the Battery Manager Personal
Edition .

Professional Edition (PRO)

With the Battery Manager Standard Edition (SE) you get the perfect solution to manage
batteries and charging devices. In addition to the embedded database you may access one
external database like Oracle or MySQL allowing you to access your data also from home.
Mutliple users may work together with your data so that the tasks may be finished by multiple
persons.

The most important features of the Battery Manager Professional Edition are:

• Convenient management of devices, batteries, manufacturers, locations, and measurements

• Supports the embedded database (single-client, single-user)

• Support for one single external database (single-client, multi-user)

• Network file system support (FTP, SFTP), multiple connections

• Cloud file system support (Dropbox, Google Drive, Amazon S3)

• Transfer database contents (arbitrary databases)

• Runs on Windows, Mac OS X, Linux, and many more systems

• Use the installers or execute directly with Java Web Start

• Supports all functions of the Personal Edition

Please visit our website to read more about the features of the Battery Manager Professional
Edition .

Enterprise Edition (EE)

The Battery Manager Enterprise Edition (EE) is the flagship of the Battery Manager product
series. It includes all features of the Personal Edition and Professional Edition, but is not limited
to one single database.
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With this edition administrators hold a powerful tool in their hands to centrally manage multiple
databases in arbitrary places and to master major tasks (like transfer of data across databases).

The following list shows the most important features of the Enterprise Edition at a glance:

• Convenient management of devices, batteries, manufacturers, locations, and measurements

• Supports the embedded database (single-client, single-user)

• Support for multiple external databases (multi-client, multi-user)

• Network file system support (FTP, SFTP), multiple connections

• Cloud file system support (Dropbox, Google Drive, Amazon S3)

• Transfer database contents (arbitrary databases)

• Runs on Windows, Mac OS X, Linux, and many more systems

• Use the installers or execute directly with Java Web Start

• Supports all functions of the Personal Edition and the Professional Edition

Please visit our website to read more about the features of the Battery Manager Enterprise
Edition .

Additional Links

• Battery Manager Personal Edition (PE)

• Battery Manager Professional Edition (PRO)

• Battery Manager Enterprise Edition (EE)

• Compare Battery Manager Editions
• Main Window

Session Window

The figure shows the components of the window for database connections with list area (1), tool
bar (2), navigation (3), dataset tabs (4), and connection tabs (5).
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List Area

The central area of the session window lists all datasets in the sections managed with the
Battery Manager software:

• My Batteries: Own batteries on the basis of the battery list items

• Battery List: Core data for the deposited batteries (available on the market)

• Locations: Where batteries are deployed and being kept

• Manufacturers: Manufacturers or dealers of devices and batteries

• Measurement: Manually or device-generated single measurements or series

Each list shows characteristic fields from the connected database, in the case of batteries for
example an internal id, the status (active, inactive, deleted/trash) as well as a name and a
manufacturer. As an example representing the other sections the following text describes the
Battery List in detail.

The Id column is a numerical identification of each dataset. The id is unique for each section
Battery List, Manufacturers etc. The St (=status) column shows the status of the dataset
(active=green, inactive=grey, deleted/trash). By default the datasets are active and therefore
used by the program. If datasets become obsolete you can either set the status to inactive or
move the items to trash. Those datasets are then never used by the program and will not be
listed if the status filter found in the tool bar is setup appropriately ("Active" entry). This allows
for a fine-grained classification of datasets, also restoring datasets after accidentally deletion is
still possible.
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The Name column shows the associated name of the respective battery, the Manufacturer
column shows the deposited producer. This column drawn with blue font may be clicked directly
with the mouse (link), where a dialog is opened to edit the manufacturer. The Size column
contains the main classification of the battery size (e.g. "9 Volt"). The Cell Type column
contains the classification of the used technology for the battery (e.g. "NiMH" for Nickle Metal
Hybrid). The Re column (=rechargeable, secondary battery) is selected if the battery may be
recharged. The Volts column shows the numerical value for the voltage measured in V
(=Volts), next to this the Capacity column is displayed (measured in mAh or Ah). In the
Comment column you can find an arbitrary text of max. 1 kilobytes length.

The main function of the list is the double-click with which the selected dataset is opened for
editing. With the context menu (right mouse button) new batteries can be created or existing
batteries can be edited. All functions of the context menu are also available in the table menu
which can be controlled with the keyboard, too.

The list is refreshed using the F5 key (see shortcuts).

Tool Bar

The tool bar component of the session window controls the display of the list area, allows for
editing datasets, and displays certain subsets with search and filter functions:

• Symbol and title: Shown on top left corner above the list

• Add (plus symbol): Starts creating a new dataset

• Edit (pen symbol): Opens the dataset for editing

• View (glasses symbol): Opens the dataset for viewing (read-only)

• Copy (document symbol): Copies the dataset with new id, fields are transferred

• Reactivate (green dot): Sets the "Active" status, dataset is used

• Deactivate (grey dot): Sets the "Inactive" status, dataset is not used

• Move to Trash (recycling symbol): Sets the "Deleted" status, dataset is not used

• Delete (red X): Deletes the dataset finally, only possible from status deleted/trash

• Refresh List (double arrow symbol): Loads the datasets from the database again

• Print Portrait: Prints the list in portrait orientation

• Print Landscape: Prints the list in landscape orientation

Additional buttons and choices for the list are available below the tool bar:

• Line numbers: Switches the display of line numbers as first column (on/off)

• Column widths: The column widths are adjusted automatically

• Clear selection: Removes the current selection, selected entries become deselected

• Select all: All datasets become selected

• Search: Starts searching for terms, the fields can be selected using the search window
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• Filter: Limits the list to display datasets matching certain filter criteria defined by the filter window
• Status chooser: Shows only datasets of certain status in list

The states of the line numbers and column width buttons are saved by the program
persistently and will be restored the next time the application is started.

In order to search for certain datasets insert a text pattern into the input field near the Search
link and start searching with ENTER oder by clicking the magnifying glass symbol to the right of
the input field. The search window is displayed automatically on the right side by default if the
pattern is edited. Here you can configure if matches shall be highlighted on-the-fly (yellow) and
which database fields shall be searched. If you are interested in all batteries of size "9 Volt" for
example then select the Sizes option and clear all other check boxes. You can do this
comfortably also by using the context menu (right mouse button) of the Sizes check box. The
search routines of most database systems do not care about the case here.

After the search the matches are presented by the list which may remain empty. In order to
support a better overview all columns with matches are highlighted with a special color. To stop
searching please click the red X next to the magnifying glass, all datasets will be displayed
again. The search can also be started by clicking the Search button of the search window.

To display only certain datasets a filter can be applied. Please click on the blue Filter link, then
the filter window is displayed automatically on the right side. Please consult the filter window
documentation for details.

Once filter criteria has been specified a click on the Apply button starts the filtering process.
Alternatively you can use the filter symbol next to the blue Filter link to start filtering. In order to
be able to re-use frequently used filters quickly the filter window let's you create templates
which are displayed by the chooser next to the blue Filter link. Please select a template here
and start filtering.

After the filtering has been processed only the matches are displayed by the list which may
remain empty. To stop filtering please click the red X next to the filter symbol, all datasets will
be displayed again.

On the right side of the filter area you can find the status chooser where certain datasets can
be listed by their current status. For example if you like all datasets from the trash being
displayed in order to delete them finally then choose "Deleted (Trash)" here. The list will then be
automatically refreshed and displays the desired datasets (may be empty).

To the right of the status chooser you can find a panel with several pieces of information for
Page and All. With the navigation you can configure how many datasets shall be presented by
the list (5, 10, 15 etc. or all). If the list shows 25 entries then 25 entries are bundled as a page,
you can see the number of datasets displayed to the right of the Page label on top. The
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number in bold font denotes the number of selected datasets on the current page. The numbers
behind All denote the number of overall selected datasets (may be on different pages) as well
as the total number of displayed datasets. These four values can be used for a quick overview
of the datasets displayed by the list including the selections.

Navigation

For large databases loaded from the Internet the navigation accelerates the displaying of
datasets since not all datasets are loaded at once. In most situations it is sufficient to load the
first 25 datasets only for example while the rest of the datasets are loaded when needed. If the
embedded database is used or the database connection is very fast then all datasets may be
loaded at once.

The navigation at the bottom edge of the session window primarily let's the user set the desired
number of displayed datasets (5, 10, 15 etc. or all). If the list shows 25 entries then 25 entries
are bundled as a page. The buttons to the right side of the number chooser allow for a fast
move to the desired page or one page forward/back or to the first/last page.

The above mentioned search and filter functions always process all datasets in the database
and not only the first 25 entries. The lists with matches may show only the first 25 entries per
page if this is configured by the navigation.

The deposited number of datasets per page in the navigation is saved by the program
persistently and will be restored the next time the application is started.

Dataset Tabs

The Battery Manager software manages the sections of a database as follows:

• My Batteries: Own batteries on the basis of the battery list items

• Battery List: Core data for the deposited batteries (available on the market)

• Locations: Where batteries are deployed and being kept

• Manufacturers: Manufacturers or dealers of devices and batteries

• Measurement: Manually or device-generated single measurements or series

By choosing a tab the underlying list for the section is being displayed. All tabs belong to the
associated session representing a certain database connection. Each connection tab shows the
entire set of dataset tabs as listed above.

Connection Tabs
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You can create as many database connections in the session window as desired. Depending
on the deployed edition multiple connections to different database types may be allowed (i.e.
Oracle, MySQL). New connections may be easily created with the application tool bar or
the database menu. If this has been successful a new tab is displayed by the session window.
New tabs become automatically active so that the managed lists become visible immediately.

In the preferences you can configure if the previous database session shall be restored the next
time the application is started or none which means that the session window does not display
any tabs here.

Please remember that multiple sessions with different database types (i.e. Oracle,

MySQL) are supported only by the Enterprise Edition. The Personal Edition allows the
use of the embedded database only while the Professional Edition is limited to
connections for one single database type.

Additional Links

• Search Window

• Filter Window
• Shortcuts

• Preferences

File System Window

The file system window shows the local file system depending on the underlying operating
system. The figure shows a typical file system under Windows with drives, the network
environment etc. For other operating systems like Linux the subdirectories of the root directory
are listed. The figure shows the window components file system overview (1), directory
overview (2), tool bar (3), context menu (4), and status bar (5).
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The navigation is intuitive by double-clicking the directories (aka folders) with the mouse. To
jump a directory level back you can double-click the first list entry with the two dots "..". By
selecting folders and/or files you can deploy the functions either via the context menu directly
on the file list (right mouse button) or with the tool bar icons. These include well-known
functions such as cut, copy, paste, delete, rename, and find.

Files and directories may be easily exchanged between the file system window, the network file
system window and other docking windows. Here you can configure which drag & drop actions
are allowed. Currently the Battery Manager supports dragging files from the file system and
network file system window. If the drag & drop turns out to be not useful for your daily work you
may disable drag & drop completely within the preferences.

File System Overview

This overview is shown on the left side of the file system window while the area width can be
adjusted by dragging the separator between the two areas. This setting is saved automatically
and restored the next time the software is started. The tree shows the entries of the computer's
file system as passed to the Java environment by the operating system (in this case Windows
7). You can see the drives and the network environment. By double-clicking the folders or by
clicking the plus symbols in front of the folders you may expand the subdirectories. The file
system overview shows only directories and no files, these will be displayed by the directory
overview on the right side when overview folders are selected. The details for the current
selection such as selection type (file or directory) as well as the full path and the selection size
(in bytes) you can find in the status bar at the bottom of the file system window.
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Above the file system overview the tool bar is located which is part of the file system window
and must not be confused with the tool bar of the Battery Manager software (larger symbols).
The tool bar icons provides you with known functions such as cut, copy, paste, delete, rename,
and find.

Directory Overview

This overview is located on the right side of the display area. The table shows the files and
directories for the selection in the file system overview where only one single entry may be
selected, otherwise the directory overview is empty. As the figure shows, all entries are listed
alphabetically with additional information. Along with the name of the entry in the first column
the table shows the permissions in the drwx column (d=directory, r=read permission, w=write
permission, x=execute permission). This detail is especially helpful for UNIX/Linux systems
where usually more restrictive permissions are configured as for Windows.

The Size column shows the length/size of the entry in abbreviated form (e.g. kilobytes), the
Type column lists the type of entry (file, directory, PDF file etc.). This information is provided
directly by the underlying operating system so that the shown types may vary. This is the case
also for the icons in the first column Name. The Modified column finally shows the date and
time of last modification in ISO notation (YYYY-MM-DD).

Within the directory overview you can also select any entries and activate the context menu
(right mouse button) or click the buttons of the window tool bar.

Tool Bar

The tool bar of the file system window contains many functions for fast navigation and for the
work with files and directories. The following list shows the functions of the tool bar:

• Parent Directory: Go one directory level up, same as double-clicking ".."
• User's Home: Go to the user's home directory

• Reset Folders: Close all open directories and create initial view

• Open: Let the application or operating system open the selected files

• Edit: Let the application or operating system edit the selected files

• Hexedit: Opens the integrated hex editor for the selected files

• Create Directory: Creates a new folder in the selected folder

• Create File: Creates an empty file in the selected folder

• Delete: Deletes selected entries, user is prompted to commit

• Rename: Gives the selected entry a new name

• Search: Starts searching for files/directories based on the name
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The button with the up arrow symbol moves to the next directory level (Parent Directory). The
house symbol navigates into the home directory of the current user (User's Home), for example
/home/axel under Linux. The next icon with the closed folder (Reset Folders) causes all
expanded directories within the file system overview to collapse so that it shows the initial state.
This is useful when many directories are opened and the window contents are confusing.

The button with the play icon (Open) opens the selected entry. This function is only available for
files, for selected directories it is deactivated. A click on the icon starts the default programs
based on the file extension. Please note, that this strongly depends on the operating system
and possibly clicking does not show any response. Similarly, the next button with the editor icon
let's the operating system start the default editor (Edit). On Windows operating systems for
example, the program WordPad may be opened if this is configured as an editor for the
selected file.

The Battery Manager software supports opening and editing some specific file types (e.g. .jpg,
.png, .gif and .xml). Such files may be directly displayed by the document window. For all
other file types the action is delegated to the underlying operating system. For the file types
supported by Battery Manager you have the choice to open the files either by the application or
the operating system (see preferences in section "Main Menu and Components"). The next
button with the dots and strokes (Hexedit) opens a file with the integrated hex editor of the
Battery Manager software. This function may be called for any file as long as the program is
able to access it.

The next icon with the plus symbol on the folder (Create Directory) may be used to create new
folders in the selected directory. This function is only activated when you selected a directory
within the file system overview. To create a new directory, a dialog will be shown prompting the
user for the name of the new folder. After successful creation of the new folder it is shown by
the file system window components. You may create new entpy files with the next button
showing the plus symbol on the document (Create File). The icon with the red X (Delete) can
be used to delete files or directories including subdirectories.

Directories and files deleted with the delete function cannot be restored
programmatically, so please backup your data first. Before entries are deleted a
security dialog is displayed which draws attention to this fact and where the user
explicitly has to confirm the deletion.

Clicking the icon with the pen (Rename) allows you to rename the selected entry while both
files and directories can be renamed. As for the creation of a directory, a special dialog is
displayed which prompts you to enter a new name. The icon with the magnifying glass (Search)
can be used to find entries starting from the selected directory. When you click on this icon, an
input field on top of the file system overview is shown where you can enter a search pattern.
The search window is shown automatically which is normally positioned on the right side of the
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docking window. There you can configure the search, for instance the search may be case
sensitive or can be based on regular expressions. The search is currently limited on the names
of files and directories, file contents cannot be searched currently.

Many of the features presented here are also available in the tool bar and can be activated also
with the associated entries in the menu bar of the Battery Manager software. For example, you
can also delete files/directories by first selecting the desired entries and then clicking the
DELETE button or alternatively by activating the Edit -> Delete menu. Where possible, the
functions of the main window menu and tool bar are configured by the docking windows.
Whether these functions are available or not is controlled by the active docking window.

Above the directory overview you can see the Path input field. Here, an absolute path can be
specified, the corresponding entry is then displayed by the other components of the file system
window (commit with ENTER). If the clipboard contains a valid path for example then you can
insert this entry and make it visible by clicking the icon to the right of the input field. Alternatively
you can commit your editing with ENTER. The path input field stores the previous entries
automatically as a history list so that it is available the next time the software is started. You can
delete the entries of this history list by activating the Clear History item from the context menu
of the input field (right mouse button).

Context Menu

Of course even the file system window - like many other applications - provides support for the
context menu which can be opened directly on the selection. You can select entries in the file
system overview or directory overview and activate the menu with the right mouse button (see
illustration). Here you can find all of the above described functions of the tool bar. In addition to
the editing functions such as cut/copy/paste you can open or edit the selection here (if
applicable), create new directories, delete entries, and rename entries. Also file searches can
directly be started from here. Besides these standard features, the context menu provides
support for additional functions specific for the Battery Manager software.

• Import Measurements: Imports device measurement datasets from files

• Cut: Like delete

• Copy: Copies the selection into the clipboard

• Paste: Inserts files/directories from the clipboard (creates copies)

• Open: Opens the selected files with program or operating system

• Edit: Starts editing the selection with program or operating system

• Hexedit: Opens the integrated hex editor for the selected files

• Create Directory: Creates a new directory in the selected folder

• Create File: Creates an empty file in the selected folder

• Delete: Deletes the selected entries, user is prompted to commit
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• Rename: Gives the selected entry a new name

• Search: Starts searching for files/directories based on the name

• Close Search: Closes the search field and the search window

Status Bar

The status bar at the bottom of the file system window shows pieces of information for the
selected files/directories. For single selections the absolute path of the entry and the exact size
in bytes are being displayed. For multiple selections or directories the status bar shows the
number of entries as well as the total size of the selection. If a path is displayed it may be
copied with the context menu (right mouse button) into the clipboard to be used by other
applications. If listing the current directory takes a long time then the status bar component
displays a progress bar or indicator on the right side.

Additional Links

• Document Window

• Search Window

• Search Results Window

• Preferences

• Network File System Window

Network File System Window

The network file system window shows a server file system depending on the used protocol and
operating system. The figure shows a typical FTP file system. The figure shows the window
components file system overview (1), directory overview (2), tool bar (3), context menu (4),
status bar (5), and sessions (6).
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The navigation is intuitive by double-clicking the directories (aka folders) with the mouse. To
jump a directory level back you can double-click the first list entry with the two dots "..". By
selecting folders and/or files you can deploy the functions either via the context menu directly
on the file list (right mouse button) or with the tool bar icons. These include well-known
functions such as cut, copy, paste, delete, rename, and find.

Files and directories may be easily exchanged between the file system window, the network file
system window and other docking windows. Here you can configure which drag & drop actions
are allowed. Currently the Battery Manager supports dragging files from the file system and
network file system window. If the drag & drop turns out to be not useful for your daily work you
may disable drag & drop completely within the preferences.

Please keep in mind that the network functionality is not supported by the Personal
Edition.

File System Overview

This overview is shown on the left side of the network file system window while the area width
can be adjusted by dragging the separator between the two areas. This setting is saved
automatically and restored the next time the software is started. The tree shows the entries of
the computer's file system as passed to the Java environment by the operating system (in this
case Windows 7). You can see the drives and the network environment. By double-clicking the
folders or by clicking the plus symbols in front of the folders you may expand the subdirectories.
The file system overview shows only directories and no files, these will be displayed by the
directory overview on the right side when overview folders are selected. The details for the
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current selection such as selection type (file or directory) as well as the full path and the
selection size (in bytes) you can find in the status bar at the bottom of the network file system
window.

Above the file system overview the tool bar is located which is part of the network file system
window and must not be confused with the tool bar of the Battery Manager software (larger
symbols). The tool bar icons provides you with known functions such as cut, copy, paste,
delete, rename, and find.

Directory Overview

This overview is located on the right side of the display area. The table shows the files and
directories for the selection in the file system overview where only one single entry may be
selected, otherwise the directory overview is empty. As the figure shows, all entries are listed
alphabetically with additional information. Along with the name of the entry in the first column
the table shows the permissions in the drwx column (d=directory, r=read permission, w=write
permission, x=execute permission). This detail is especially helpful for UNIX/Linux systems
where usually more restrictive permissions are configured as for Windows.

The Size column shows the length/size of the entry in abbreviated form (e.g. kilobytes), the
Type column lists the type of entry (file, directory, digest file etc.). This information is provided
directly by the underlying operating system so that the shown types may vary. This is the case
also for the icons in the first column Name. The Modified column finally shows the date and
time of last modification in ISO notation (YYYY-MM-DD).

Within the directory overview you can also select any entries and activate the context menu
(right mouse button) or click the buttons of the window tool bar. In the preferences you can
configure how file symbols and types should be determined by the program. Here, you can
choose either to show default icons (faster) or to show symbols and types of your computer
(costly, since temporary files have to be created).

Tool Bar

The tool bar of the network file system window contains many functions for fast navigation and
for the work with files and directories. The following list shows the functions of the tool bar:

• Parent Directory: Go one directory level up, same as double-clicking ".."
• User's Home: Go to the user's home directory

• Reset Folders: Close all open directories and create initial view

• Open: Let the application or operating system open the selected files

• Edit: Let the application or operating system edit the selected files
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• Hexedit: Opens the integrated hex editor for the selected files

• Create Directory: Creates a new folder in the selected folder

• Create File: Creates an empty file in the selected folder

• Delete: Deletes selected entries, user is prompted to commit

• Rename: Gives the selected entry a new name

• Search: Starts searching for files/directories based on the name

The button with the up arrow symbol moves to the next directory level (Parent Directory). The
house symbol navigates into the home directory of the current user (User's Home), for example
/home/axel under Linux. The next icon with the closed folder (Reset Folders) causes all
expanded directories within the file system overview to collapse so that it shows the initial state.
This is useful when many directories are opened and the window contents are confusing.

The button with the play icon (Open) opens the selected entry. This function is only available for
files, for selected directories it is deactivated. A click on the icon starts the default programs
based on the file extension. Please note, that this strongly depends on the operating system
and possibly clicking does not show any response. Similarly, the next button with the editor icon
let's the operating system start the default editor (Edit). On Windows operating systems for
example, the program WordPad may be opened if this is configured as an editor for the
selected file.

The Battery Manager software supports opening and editing some specific file types (e.g. .jpg,
.png, .gif and .xml). Such files may be directly displayed by the document window. For all
other file types the action is delegated to the underlying operating system. For the file types
supported by Battery Manager you have the choice to open the files either by the application or
the operating system (see preferences in section "Main Menu and Components"). The next
button with the dots and strokes (Hexedit) opens a file with the integrated hex editor of the
Battery Manager software. This function may be called for any file as long as the program is
able to access it.

The next icon with the plus symbol on the folder (Create Directory) may be used to create new
folders in the selected directory. This function is only activated when you selected a directory
within the file system overview. To create a new directory, a dialog will be shown prompting the
user for the name of the new folder. After successful creation of the new folder it is shown by
the file system window components. You may create new entpy files with the next button
showing the plus symbol on the document (Create File). The icon with the red X (Delete) can
be used to delete files or directories including subdirectories.

Directories and files deleted with the delete function cannot be restored
programmatically, so please backup your data first. Before entries are deleted a
security dialog is displayed which draws attention to this fact and where the user
explicitly has to confirm the deletion.
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Clicking the icon with the pen (Rename) allows you to rename the selected entry while both
files and directories can be renamed. As for the creation of a directory, a special dialog is
displayed which prompts you to enter a new name. The icon with the magnifying glass (Search)
can be used to find entries starting from the selected directory. When you click on this icon, an
input field on top of the file system overview is shown where you can enter a search pattern.
The search window is shown automatically which is normally positioned on the right side of the
docking window. There you can configure the search, for instance the search may be case
sensitive or can be based on regular expressions. The search is currently limited on the names
of files and directories, file contents cannot be searched currently.

Many of the features presented here are also available in the tool bar and can be activated also
with the associated entries in the menu bar of the Battery Manager software. For example, you
can also delete files/directories by first selecting the desired entries and then clicking the
DELETE button or alternatively by activating the Edit -> Delete menu. Where possible, the
functions of the main window menu and tool bar are configured by the docking windows.
Whether these functions are available or not is controlled by the active docking window.

Above the directory overview you can see the Path input field. Here, an absolute path or an
URL can be specified, the corresponding entry is then displayed by the other components of the
network file system window (commit with ENTER). If the clipboard contains a valid path for
example then you can insert this entry and make it visible by clicking the icon to the right of the
input field. Alternatively you can commit your editing with ENTER. The path input field stores
the previous entries automatically as a history list so that it is available the next time the
software is started. You can delete the entries of this history list by activating the Clear History
item from the context menu of the input field (right mouse button).

Context Menu

Of course even the network file system window - like many other applications - provides support
for the context menu which can be opened directly on the selection. You can select entries in
the file system overview or directory overview and activate the menu with the right mouse
button (see illustration). Here you can find all of the above described functions of the tool bar. In
addition to the editing functions such as cut/copy/paste you can open or edit the selection here
(if applicable), create new directories, delete entries, and rename entries. Also file searches can
directly be started from here. Besides these standard features, the context menu provides
support for additional functions specific for the Battery Manager software.

• Cut: Like delete

• Copy: Copies the selection into the clipboard

• Paste: Inserts files/directories from the clipboard (creates copies)

• Open: Opens the selected files with program or operating system
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• Edit: Starts editing the selection with program or operating system

• Hexedit: Opens the integrated hex editor for the selected files

• Create Directory: Creates a new directory in the selected folder

• Create File: Creates an empty file in the selected folder

• Delete: Deletes the selected entries, user is prompted to commit

• Rename: Gives the selected entry a new name

• Search: Starts searching for files/directories based on the name

• Close Search: Closes the search field and the search window

Status Bar

The status bar at the bottom of the network file system window shows pieces of information for
the selected files/directories. For single selections the absolute path of the entry and the exact
size in bytes are being displayed. For multiple selections or directories the status bar shows the
number of entries as well as the total size of the selection. If a path is displayed it may be
copied with the context menu (right mouse button) into the clipboard to be used by other
applications. Path URLs are always copied into clipboard without username/password for
security reasons since also other programs may access the data. If listing the current directory
e.g. for slow ISDN dial-up connections takes a long time then the status bar component
displays a progress bar or indicator on the right side.

Sessions

For each of the connections the window displays a separate tab showing the connection name.
The tabs may be closed using the red X button, active connections are then disconnected. You
should wait for all tasks to be properly finished to avoid data loss. New sessions may be created
either with the Network menu in the main menu, using the tool bar, or the network connection
management.

Within the preferences you can configure if sessions should be created automatically on
program start. You have the choice here to start with no connections or to restore the previous
connections.

Additional Links

• Edit Connections

• Document Window

• Search Window

• Search Results Window

• Preferences
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• File System Window

Document Window

The figure shows the components of the document window with editing area (1), tool bar (2),
status bar (3) and document tabs (4).

Editing Area

The center of the document window shows the contents of the files loaded from the PC or the
network. The figure shows an opened graphics file shot_custom_eng_US.png as well as the
message digest file apache-tomcat-5.5.31.exe.digest. Currently the following file types are
supported by the window which means that such files can be viewed or edited:

• Graphics files *.bmp, *.jpg, *.wbmp, *.png, *.gif (viewing only)

• Text files *.txt, *.log, *.asc, *.sig (viewing/editing)

• XML files *.xml (viewing/editing )

• Java Properties *.conf, *.properties (viewing/editing)

For these file types arbitrary file extensions may be configured in the preferences. In addition to
that you can configure if such files are opened/edited using the document window or the
operating system based on the file extension. Please note, that this strongly depends on the
operating system and possibly the system does not show any response. On Windows operating
systems for example, the program WordPad may be opened if this is configured as an editor for
the selected file.
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The open function distinguishes between opening and editing files. While editing normally
causes the appropriate editor to be shown in the document window opening may cause a
specific program function to be executed.

Besides the file types mentioned above the Hexedit function of the file system window and
network file system window can be used to open any readable file. The editing area therefore
shows a special hex editor component, where arbitrary data may be presented on the
byte-level. In order to prevent from loading of very large files in the editing area, you can
configure a maximum file size within the preferences. Additionally you can limit the number of
currently opened files so that the editing area does not become confusing.

In the preferences you can find more ways to configure the document window. There it is
possible to start the window with either no documents or with the previous documents. Also you
can configure how to handle files with pending changes if tabs shall be closed.

Any supported file type is displayed individually by the document window. XML documents for
example are presented using syntax highlighting where XML elements, attributes etc. are
colored specially. This allows for an easy overview of the opened files.

Tool Bar

The toolbar of the document window provides simple functions for the work with the opened
files. The following listing shows the tool bar functions, which may vary for the supported file
types:

• Save: Stores the file back to the original data source (e.g. file on PC)

• Save as file: Stores the content into a selectable file on the PC

• Save as network file: Stores the content into a selectable file on the server

• Properties: Shows the properties of the loaded ressources

The button with the diskette dymbol (Save) saves the current content back into the file or
network file where it was originally loaded from. If the content has been loaded from a different
source (e.g. from clipboard) this function is not possible, the button is disabled then. The next
button with the arrow on the folder (Save as file) saves the content into a local file of your
choice which can be specified with a dialog. The button with the server arrow (Save as network
file) can be used similarily to save the content into a network file. The detailed properties of the
resource including size and used editor type are being displayed when the info icon is clicked
(Properties). If possible for the file type additional symbols may be shown here e.g. for printing.

Status Bar
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The status bar at the bottom of the document window shows messages of the editors for
example if resources are saved. If saving a network files for instance takes a long time then the
status bar component displays a progress bar or indicator on the right side.

Document Tabs

For each of the opened files and network files (resource in general) the window displays a
separate tab showing the resource name. The tab tooltips display the full names or URLs of the
resources. The tabs may be closed using the red X button, the contents are being removed
from main memory. You should always save changed files properly to avoid data loss.

Within the preferences you can configure how to proceed if changed documents are closed:

• Ask me what to do with changed files
• Save changed files automatically when closed
• Close changed files without saving (changes are lost)

Within the preferences you can configure if documents should be reopened automatically on
program start. You have the choice here to start with no documents (empty window) or to
restore the previous documents.

Additional Links

• File System Window
• Network File System Window
• Preferences

Device Window

The figure shows typical device window components for a charging device with device area (1),
figure (2), live data (3), and status bar (4). For each connected device a separate window is
generated by the application which is displayed as separate window next to the main window by
default. The window may be displayed by the dock as well.

The device window components vary depending on the supported device:

• Charging Device

• Barcode Reader

• RFID Reader

• EnerGenie Power Management

• UniControl 4.36
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Charging Device

The device window shows 4 areas for charging devices (here: Charge Manager 2010):

• Device area (1): Device chooser and specific settings

• Figure (2): Schematic representation of the device with charging bays

• Live Data (3): Display of the data generated by device

• Status Bar (4): Helpful information, warnings, and error messages

After connecting a new device it is recommended to apply the basic settings first. If the device
window has been created by the device wizard or manually some settings can be made from
within the device area. Please click on the title or the plus symbol in order to expand the area.
After you have completed the setup this area should be collapsed again since it not required for
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the operation and since the other components figure and live data require the availabe space
on the monitor.

First of all please choose the connected device. Since devices are stored in the database a
connection must have been established in the session window. The device list may be
refreshed using the button right to the chooser. If you like to change the configuration of the
selected device please click the blue Edit link. The appropriate type is automatically selected if
a device has been selected. If you have not already deposited a device in the database you can
set a type for your charging device here. Logging of measurements is not possible then. It is
recommended to configure a device in the database and to select it in the device window.

Below this the serial settings are listed (like Baud Rate). The area with charging options
contains the following options:

• Use latest recognized battery automatically
• Reset barcode/RFID tag ID afterwards

These settings let's you control the interaction with barcode readers and RFID readers which
can be used for a quick battery identification. If a barcode has been recognized and a battery is
deposited then the barcode reader device window shows this battery. With the Use latest
recognized battery automatically option this battery is used automatically once it is inserted
into a charging bay so that manual setting is not necessary and logging may start immediately.
The option Reset barcode/RFID tag ID afterwards may be set in order to reset the barcode
after it has been transferred from the barcode device window into the charging device window
(default).

The logging options currently consist of the following options:

• Start logging automatically
• Stop logging automatically
• Log raw data from device
• Log datasets every n seconds

Once a battery has been inserted into the charging device and has been identified by a barcode
or RFID tag the logging of measurement data may be started. In order to do this automatically
please enable the Start logging automatically option. Enable Stop logging automatically to
get this done automatically if a battery is removed from a charging bay. The Log raw data from
device option can be selected if you like the raw data from the device be logged in addition to
the standard values for voltage, current etc. (default: off). The interval for the loggin is controlled
using the Log datasets every n seconds option where a value in seconds is specified.

Since device data logging may produce many, many datasets to be stored the interval should

not be set too small. A reasonable value for logging is 60 seconds.
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The figure (2) shows a schematic representation of the connected device. The charging bays
may be clicked in order to select a battery from the database. Measurement data may only be
logged if a battery has been identified from the database.

The live data (3) area is devied into sections for each charging bay. For each bay the sections
display the measurement data from the device. The currently executed charging program of the
device is printed on the right side (e.g. CHA=Charge). Like the bay buttons of the figure also the
live data section contain buttons to select a battery from the database. If logging is not
started/stopped automatically then this can be done separately for each bay using the ball
buttons. The header of each bay section displays the duration, the battery name, as well as the
executed charging program and the number of log datasets.

On the status bar (4) of the device window prints notices, warnings, or error messages from
time to time. The symbol on the right side shows the current status (i.e. connected or not
connected).

Barcode Reader

The device window shows 3 areas for barcode readers (here: Honeywell Voyager 9520):

• Device area (1): Device chooser and specific settings

• Live Data (3): Display of the data generated by device
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• Status Bar (4): Helpful information, warnings, and error messages

After connecting a new device it is recommended to apply the basic settings first. If the device
window has been created by the device wizard or manually some settings can be made from
within the device area. Please click on the title or the plus symbol in order to expand the area.
After you have completed the setup this area should be collapsed again since it not required for
the operation.

First of all please choose the connected device. Since devices are stored in the database a
connection must have been established in the session window. The device list may be
refreshed using the button right to the chooser. If you like to change the configuration of the
selected device please click the blue Edit link. The appropriate type is automatically selected if
a device has been selected. If you have not already deposited a device in the database you can
set a type for your barcode device here. In the case of barcode readers a device in the
database is required since the settings like tag format are stored in the database. Choosing a
type only is not possible here.

Below this the Serial Settings are listed (like Baud Rate). The area with barcode device
settings contains the following options:

• Barcode Format
• Expression
• Group

The Barcode Format specifies the data format used for barcodes recognized by the device.
Common value is the format Default (TEXT/CRLF). Please consult the documenation of your
barcode reader to determine the supported format. For each barcode format an appropriate
regular expression must be deposited which in combination with the group serves to
recognize barcodes. It is recommened to use the available barcode formats since expressions
and groups are already deposited here. Both values may also be specified manually using the
device management in order to support rarely used barcode formats.

The Barcode Settings include the following options:

• Beep when new barcode is recognized
• Copy barcode to clipboard
• Reset barcode after n seconds

Since not all barcode readers may produce sounds you can let your PC create a beep with the
Beep when new barcode is recognized option once a new barcode has been recognized. In
order to share barcodes with other programs please enable the Copy barcode to clipboard
option, the barcodes are then copied to clipboard after recognition. A recognized barcode may
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be reset after a certain time period by setting a value in seconds for the Reset barcode after n
seconds option.

The Live Data (3) area shows the recognized barcode, the button to the right may be clicked to
reset the value. If a database connection exists and a battery has been deposited for the
recognized barcode then this battery is displayed by the Battery chooser. Simultaneously the
battery photo is displayed if configured.

On the status bar (4) of the device window prints notices, warnings, or error messages from
time to time. The symbol on the right side shows the current status (i.e. connected or not
connected).

It is recommended to use barcode readers with integrated laser instead of other technologies
like CCD in order to achieve better recognition results even for printed barcodes. The barcodes
for the rechargeables managed with Battery Manager may be directly printed from the My
Batteries tab found on the session window. Please select the desired batteries here and call
the Print Barcodes... context menu with the right mouse button. A print preview is displayed to
be printed with a connected printer. The resolution of the printer used should be at least 300 dpi
for a proper recognition. The common printing options of the program are also applied when
printing barcodes, e.g. you can specify a default printer or turn off the preview here.

The printed barcodes (Code 128) will have a suitable size so that they can be attached without
problems to even the smaller AAA/micro batteries. You could use self-adhesive paper or regular
printer paper and attach the strips with Tesa band for example. Please keep some white space
to the left and right sides of the barcodes for proper recognition. The battery names are used as
barcode data by default. If the names consist of more than 16 characters or contain non-ASCII
characters (0-127) like German Umlauts then the unique database ID like MYID=123 is used
instead. Both data structures name and ID are detected automatically by the software which
finds the associated batteries in the database.

RFID Reader
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The device window shows 3 areas for RFID readers (here: A30A-RS232):

• Device area (1): Device chooser and specific settings

• Live Data (3): Display of the data generated by device

• Status Bar (4): Helpful information, warnings, and error messages

After connecting a new device it is recommended to apply the basic settings first. If the device
window has been created by the device wizard or manually some settings can be made from
within the device area. Please click on the title or the plus symbol in order to expand the area.
After you have completed the setup this area should be collapsed again since it not required for
the operation.

First of all please choose the connected device. Since devices are stored in the database a
connection must have been established in the session window. The device list may be
refreshed using the button right to the chooser. If you like to change the configuration of the
selected device please click the blue Edit link. The appropriate type is automatically selected if
a device has been selected. If you have not already deposited a device in the database you can
set a type for your RFID device here. In the case of RFID readers a device in the database is
required since the settings like tag format are stored in the database. Choosing a type only is
not possible here.
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Below this the serial settings are listed (like Baud Rate). The area with RFID device settings
contains the following options:

• Tag Format
• Expression
• Group
• Convert To

The tag format specifies the data format used for tag IDs recognized by the device. Common
values are hexadecimal 10 or decimal 10. Please consult the documenation of your RFID
reader to determine the supported format. For each tag format an appropriate regular
expression must be deposited which in combination with the group serves to recognize tag
IDs. It is recommened to use the available tag formats since expressions and groups are
already deposited here. Both values may also be specified manually using the device
management in order to support rarely used tag formats. The Convert To option may be used
to normalize tag IDs generated by different readers.

The RFID Settings include the following options:

• Beep when new tag ID is recognized
• Copy tag ID to clipboard
• Reset tag ID after n seconds

Since not all RFID readers may produce sounds you can let your PC create a beep with the
Beep when new tag ID is recognized option once a new tag ID has been recognized. In order
to share tag IDs with other programs please enable the Copy tag ID to clipboard option, the
tag IDs are then copied to clipboard after recognition. A recognized tag ID may be reset after a
certain time period by setting a value in seconds for the Reset tag ID after n seconds option.

The Live Data (3) area shows the recognized tag ID, the button to the right may be clicked to
reset the ID. If a database connection exists and a battery has been deposited for the
recognized tag ID then this battery is displayed by the Battery chooser. Simultaneously the
battery photo is displayed if configured.

On the status bar (4) of the device window prints notices, warnings, or error messages from
time to time. The symbol on the right side shows the current status (i.e. connected or not
connected).

EnerGenie Power Management

Battery Manager 1.6.3 User Manual - Device Window

34 / 130



The device window shows 4 areas for programmable plug devices EnerGenie (currently
EG-PM2-LAN, EG-PMS2-LAN und EG-PMS2-WLAN) :

• Device area (1): Device chooser and specific settings

• Figure (2): Schematic representation of the device with plugs

• Live Data (3): Display of the data generated by device

• Status Bar (4): Helpful information, warnings, and error messages

After connecting a new device it is recommended to apply the basic settings first. If the device
window has been created by the device wizard or manually some settings can be made from
within the device area. Please click on the title or the plus symbol in order to expand the area.
After you have completed the setup this area should be collapsed again since it not required for
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the operation and since the other components figure and Live Data require the availabe space
on the monitor. With the red X in the right top corner of the device area the device window may
be exited (commit required). The settings of the exited device will be lost here.

First of all please choose the connected device. Since devices are stored in the database a
connection must have been established in the session window. The device list may be
refreshed using the button right to the chooser. If you like to change the configuration of the
selected device please click the blue Edit link. The appropriate type is automatically selected if
a device has been selected. If you have not already deposited a device in the database you can
set a type for your EnerGenie device here.

The area with EG-PM2-LAN Settings contains the following options:

• Host name or IP
• Device password
• Refresh states every n seconds
• States on start (1-4)
• States on exit (1-4)

In the first input field Host name or IP you can deposit the server name or ip address used by
the EnerGenie device. The device password consists of multiple ASCII characters, the
EnerGenie device uses 1 as default password. To display the password as cleartext (not
masked) please click on the button right next to the input field.

The option Refresh states every n seconds causes the window to read the states of the plugs
from time to time. If you like to do this manually then please leave this input field empty. By
default an interval of 60 seconds is deposited here.

In addition to the initial device states you can configure certain state configurations here to be
automatically activated if the Battery Manager gets started or exited. With States on start you
can configure which of the 4 plugs shall be turned on or off, with States on exit you can
configure which of the 4 plugs shall be turned on or off if the Battery Manager is terminated.
With these functions you can turn the other devices controlled by Battery Manager like chargers
or RFID readers on or off if the software gets started and exited (energy saving). If you do not
like to use these functions please deselect the States on start and/or States on exit check
boxes.

The figure (2) shows a schematic representation of the connected device. The plugs may be
clicked in order to toggle the current states (ON/OFF). If the device is not connected or a wrong
password is used then the buttons are not visible.

The live data (3) area is devied into sections for each plug. For each plug the sections display
the state data from the device where each plug can be given a name to reflect the connected
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devices. Like the plug buttons of the figure also the live data section contain buttons to turn the
plugs on/off. In cases of emergency the four plugs can be turned off at once with the ALL OFF
button.

On the status bar (4) of the device window prints notices, warnings, or error messages from
time to time. The symbol on the right side shows the current status (i.e. connected or not
connected).

UniControl 4.36

The device window shows 4 areas for programmable plug devices UniControl 4.36:

• Device area (1): Device chooser and specific settings
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• Figure (2): Schematic representation of the device with plugs

• Live Data (3): Display of the data generated by device

• Status Bar (4): Helpful information, warnings, and error messages

After connecting a new device it is recommended to apply the basic settings first. If the device
window has been created by the device wizard or manually some settings can be made from
within the device area. Please click on the title or the plus symbol in order to expand the area.
After you have completed the setup this area should be collapsed again since it not required for
the operation and since the other components figure and Live Data require the availabe space
on the monitor.

First of all please choose the connected device. Since devices are stored in the database a
connection must have been established in the session window. The device list may be
refreshed using the button right to the chooser. If you like to change the configuration of the
selected device please click the blue Edit link. The appropriate type is automatically selected if
a device has been selected. If you have not already deposited a device in the database you can
set a type for your UniControl 4.36 device here.

Below this the serial settings are listed (like Baud Rate). The area with UniControl settings
contains the following options:

• Device password
• Refresh states every n seconds
• Display software version
• Display initial device states
• Store initial device states
• States on start (1-4)
• States on exit (1-4)

The device password always consists of 4 ASCII characters, the UniControl 4.36 device uses
1234 as default password. To display the password as cleartext (not masked) please click on
the button right next to the input field. With the pencil symbol you can change the password by
specifying the old and the new passwords first, the confirmation helps to avoid input failures.
After storing the new password in the device a message is displayed on the status bar, the new
password is displayed by the input field automatically.

The option Refresh states every n seconds causes the window to read the states of the plugs
from time to time. If you like to do this manually then please leave this input field empty. By
default an interval of 60 seconds is deposited here. Right to the input field you'll find several
buttons to display the device software version as well as the configured initial device states. If
you like to adjust the states then please set the plugs as desired (ON/OFF) and click the Store
initial device states button.
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In addition to the initial device states you can configure certain state configurations here to be
automatically activated if the Battery Manager gets started or exited. With States on start you
can configure which of the 4 plugs shall be turned on or off, with States on exit you can
configure which of the 4 plugs shall be turned on or off if the Battery Manager is terminated.
With these functions you can turn the other devices controlled by Battery Manager like chargers
or RFID readers on or off if the software gets started and exited (energy saving). If you do not
like to use these functions please deselect the States on start and/or States on exit check
boxes.

The figure (2) shows a schematic representation of the connected device. The plugs may be
clicked in order to toggle the current states (ON/OFF). If the device is not connected or a wrong
password is used then the buttons are not visible.

The live data (3) area is devied into sections for each plug. For each plug the sections display
the state data from the device where each plug can be given a name to reflect the connected
devices. Like the plug buttons of the figure also the live data section contain buttons to turn the
plugs on/off. In cases of emergency the four plugs can be turned off at once with the ALL OFF
button.

On the status bar (4) of the device window prints notices, warnings, or error messages from
time to time. The symbol on the right side shows the current status (i.e. connected or not
connected).

Additional Links

• Device management

• Regular expressions

• Session window

Search Window

This window allows for searching files/directories based on the name (not the content). The
search window is usually located on the right side of the screen and is opened by the file
system window or network file system window automatically when the search function is
activated (also the search pettern is specified there). If this behavior is not desired, you can
disable the Automatic flag in the context menu (right mouse button) of the docking window
button Search.
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The right figure shows the search window if the search function has been called from the
session window where datasets from a database are being searched for. The search window
shows the appropriate content depending on the currently selected major docking window.

• Simple search: Direct pattern search (wildcards like * are not supported)

• Case sensitive: The case of the pattern matters (lower/upper)

• Whole words only: If a single word is matched then the file/directory is matched

• Regular expressions: Flexible search e.g. for files starting with numbers

• Check on-the-fly: Errors in regular expressions are detected early

• Files: Search for regular files

• Directories: Search for regular directories

• Hidden entries: Search for hidden entries, depends on the operating system

The search window lets you configure the search in many ways. You can choose the simple
search here where all files/directories are searched based on the given search pattern. If you
like the search being case sensitive, please select the Case sensitive option for the simple
search. The option Whole words only configures the search engine to search for words within
the entry names. While in this mode, only one single part of the entry names needs to match
the pattern to be shown by the hit list. Thus, you can search for OR-combined sub-patterns
here.

In some cases, the simple search is inadequate, for example if all file names shall be listed that
start with a digit. In these cases, you can use regular expressions by selecting the Regular
expressions option, where the search pattern specified with the input field of the file system
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window must be a valid regular expression. To detect errors as early as possible, the software
can be configured to check the pattern input already while you are typing. Please activate the
Check on-the-fly option to do so. If you want to search for files and/or directories and/or hidden
entries then you can select the options Files, Directories, and Hidden entries accordingly.

Start Searching

The search can also be started directly from the search window once all settings are
appropriate. Click the Search button at the bottom of the window. If the search is not possible
for example due to a faulty regular expression, this button will be disabled. If the
auto-show/auto-hide feature is enabled when the search is started, then the search window is
hidden automatically and a progress dialog is opened which informs you about the current state
of the search operation. This dialog can also be configured to perform the search in the
background so that you can continue working with the application.

After completing the search, the results are presented by the search results window.

Additional Links

• File System Window
• Network File System Window
• Session Window
• Regular Expressions
• Search Results Window

Filter Window

Here you can filter the datasets shown by the session window by certain criteria which means
that only the desired datasets are being displayed. In contrary to the search function which
always processes all fields of a dataset the filter function can be used to display only those
datasets with certain fields that match the given filter settings. For example you can filter all
batteries with lifecycle phase "New" or the size "AAA".

The filter window is usually located on the right side of the screen and is opened by the session
window automatically when the filter function is activated. This window also provides the filter
templates which can be defined arbitrarily in order to apply commonly used filters quickly. Each
type of list (My Batteries, Battery List etc.) has its own filter settings.

The single filter settings "By Lifecycle", "By Size" etc. can be expanded/collapsed by clicking the
headers or the plus/minus symbol in order to configure the filters. The buttons above the filters
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can be used to reset, refresh, expand/collapse, and to set the logic operator. The template
chooser at the bottom allows for storing arbitrary filters as templates which may be applied
directly from the session window.

By clicking the Apply button the filters are applied based on the current settings.

• Reset filters: Reset all filters to default selection (no filters)

• Refresh filters: Refresh all filters, i.e. reflect database changes

• Expand all filters: Make all available filters visible in order to choose a selection

• Collapse all filters: Collapses all filters (default)

• Logic operator: Combine the single filters with either AND or OR operators, control the selection

• Add template: Save the currently selected filters as template

• Delete template: Remove the currently selected template

• Edit template: Rename the currently selected template

• Sort templates: Sort the template list alphabetically or show in order of creation otherwise

The filters can be configured conveniently from here: with the Reset filters button above the
filters you can reset all filters at once (no filters). If filter values are populated from the database
(e.g. battery sizes) and new values have been added then the filters may be updated by using
the Refresh filters button. With the buttons Expand all filters and Collapse all filters all filters
can be expanded/collapsed in order to adjust multiple filters at once.

By default multiple filters are combined using the AND operator which means that such
batteries are displayed that are in the "New" lifecycle phase and have the size "AAA". Here,
both filters are required to match in order to let the battery dataset show up. If a single filter shall
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be sufficient so that either the "New" lifecycle phase or the size "AAA" matches please choose
OR as Logic operator here.

Below the filters you can manage filter templates which are displayed by the session window so
that configured filter settings can be used again and again easily. With Add template you can
create a new template while the name must be unique and not already be used. The template
name can be specified with an input dialog which is also displayed if the Edit template button is
clicked in order to rename the current template. With Delete template the current filter template
can be removed from the list. The button Sort templates allows for sorting the template list
alphabetically or for showing the items in the order of creation otherwise.

Start Filtering

The filtering can also be started directly from the filter window once all settings are appropriate.
Click the Apply button at the bottom of the window. If the filtering is not possible for example
due to missing filters, this button will be disabled. If the auto-show/auto-hide feature is enabled
when the filtering is started, then the filter window is hidden automatically and the program
switches to the session window displaying the filtered datasets. Here, the filter templates may
be selected and applied by simply clicking a button.

Additional Links

• Session Window

Output Window

The output window of the Battery Manager software shows the log messages generated by the
running program which are also written to the log file in the configuration directory. The window
is divided into tabs where the log file battman.log and also the log file derby.log are being
displayed if the embedded database has been started. The log messages are interesting if you
plan to contact the Leisenfels support since all relevant pieces of information concerning the
running application are documented here precisely. For the daily work with the software this
output is usually not important.
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• Latest Entry: Auto-scroll to end of file (latest log entries)

• Clear Text: Clear text area (not log file)

• Copy to Clipboard: Copy contents to clipboard for other programs

• Show Log File: Show log file in file system window

The tool bar at the right side of this window allows you to control the display. The scroll symbol
(Latest Entry) can be selected so that the visible text area is automatically scrolled to the last
row. So you can always see the latest log messages. You have to turn off this feature if you
want to see the log messages at the beginning of the log file. This setting is stored when the
application is terminated and restored the next time it is started.

The symbol with the empty sheet (Clear Text) clears the text in the text area but does not touch
the log file contents. Use this function if a lot of log messages have been generated by the
program and the scrolling becomes too imprecise. Click the clipboard icon (Copy to Clipboard)
to copy the complete text into the clipboard of the operating system. This can be useful when
forwarding log files to the Leisenfels support without the log file being attached to an e-mail. The
button with the green arrow (Show Log File) shows the log file in the file system window.

As an alternative to the buttons, the corresponding functions are also provided by the context
menus which you can activate with the right mouse button on the text area (see figure).

Additional Links

• File System Window

Task Window

The task window is used by the Battery Manager software to list all tasks that have been
executed in the background, by the progress dialog, or that are currently running. The figure
shows a completed session creation and a search for .exe files.
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If a task has not yet completed, its status is usually shown as a progress indicator with the
remaining time shown by the ETA column (Estimated Time Access, here 1 minute and 15
seconds). The Message column presents the last message generated by the task, while the
final status is indicated by a special icon in front of the message in most cases. The final status
will also be displayed as text by the Status column. The Duration column contains the time
period as hours:minutes:seconds that the task execution took so far or that the task execution
took finally. The Prio column shows a number to indicate which priority the task has been
executed with.

• Order: Show latest task on top, as started otherwise

• Clear List: Delete all completed tasks from the list

• Stop Task: Cancel the selected tasks if possible

• Execute Again: Restart the selected tasks if supported

• Delete Task: Delete the selected tasks from the list

• Reset Auto Mode: Reset auto backgrounding mode (ask with dialog)

The left tool bar can be used to manage the list of tasks. The button with the blue arrow (Order)
can be clicked to show the latest task on top of the list or in the order as they were started
otherwise. The activated magic wand icon (Reset Auto Mode) shows the window automatically
whenever a new task is passed to be managed. This may be done easily from the progress
dialog by clicking the Background button. The icon with the empty table (Clear List) can be
used to delete the entire list of tasks with one single click. This feature is available only if all the
tasks have been completed. If the docking window is configured to be Automatic, then
removing the entire list items causes the task window to be hidden, too.

The gear icon with the red square (Stop Task) is enabled when a running task is selected
which can be terminated. A click on this button causes the task being immediately canceled.
This is useful for example to abort a long running search operation. The task is assigned the
Canceled status here. If you like a task to be executed again (if supported by the task), then
please select the task in the list and click the gear icon with the green triangle (Execute Again).
The task is then restarted based on the previous settings. This is also possible for canceled
tasks, unless the task declares itself not to be restartable. If you like to remove tasks from the
list, please use the gear icon with the red X (Delete Task).
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As an alternative to the buttons, the corresponding functions are also provided by the context
menus which you can activate with the right mouse button on the selected list entry (see figure).

Additional Links

• Search Window

• File System Window
• Network File System Window

Search Results Window

After the search has been initiated from the search window and the results are available, these
are listed by the search results window (see illustration). Here all hits are listed while the list is
sorted alphabetically by default. You can select the hit list entries as in the file system window
and also activate the context menu (right mouse button). This menu usually provides all
features of the file system window. The details for the current selection such as the selection
type (file or directory) as well as the full path and the selection size (in bytes) is displayed by the
status bar at the bottom of the docking window.

The search results window is structured with tabs with each tab assigned to a search operation.
This way, virtually any number of operations can be displayed here without the need for multiple
result windows. The buttons on the left side allow to automatically show/hide the window like
the search window (magic wand symbol). The icon with the empty window can be used to close
all displayed result tabs. This function is useful if you like to remove all search results with one
single click. If the docking window is configured to be Automatic then the docking window is
also automatically hidden.
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• Sorting: Sort matches alphabetically or in order of finding

• Open: Opens the selected files with program or operating system

• Edit: Starts editing the selection with program or operating system

• Hexedit: Opens the integrated hex editor for the selected files

• Delete: Deletes the selected entries, user is prompted to commit

• Rename: Gives the selected entry a new name

• Show Entry: Show entry in file system window or network file system window

The right tool bar contains various functions to control the display of the hit list. With the AZ icon
(Sorting) you can either sort the list alphabetically (default) or show the items in the order that
the files have been found.

The button with the play icon (Open) lets the program or operating system open this entry. This
function is only available for files, this button is deactivated for directories. A click on this icon
starts the standard programs associated with the selected file extension or one of the integrated
editors. Please note, however, that this is strongly dependent on the operating system and
there may be no response at all. This is also true for the next button with the editor icon (Edit)
which can be used to let the program or operating system start the standard editor for the
selected file. Under Windows operating systems for example the program WordPad is opened if
this is the default editor for the selected file.

The Battery Manager software supports opening and editing some specific file types (e.g. .jpg,
.png, .gif and .xml). Such files may be directly displayed by the document window. For all
other file types the action is delegated to the underlying operating system. For the file types
supported by Battery Manager you have the choice to open the files either by the application or
the operating system (see preferences in section "Main Menu and Components"). The next
button with the dots and strokes (Hexedit) opens a file with the integrated hex editor of the
Battery Manager software. This function may be called for any file as long as the program is
able to access it.

The icon with the red X (Delete) can be used to delete the selected files and directories
including subdirectories. A click on the icon with the pen (Rename) allows you to rename the
selected entry which may be both files or directories. Similar to the creation of a directory, a
special dialog is displayed that prompts you to enter the new name. The button with the green
arrow (Show Entry) shows the selected hit list entry in the file system window. This symbol
varies a little if the search has been started from the network file system window.

Directories and files deleted with the delete function cannot be restored
programmatically, so please backup your data first. Before entries are deleted a security
dialog is displayed which draws attention to this fact and where the user explicitly has to
confirm the deletion.
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As an alternative to the buttons, the corresponding functions for the search results window are
also provided by the context menus which you can activate with the right mouse button on the
entries of the hit list. The context menu items are almost identical to the items provided by the
file system window extended by special items such as Show Entry.

Additional Links

• Search Window

• File System Window
• Network File System Window

Update Log Window

This window is automatically displayed if database updates are available. This may be the case
if a new program version has been installed and the software is started the first time afterwards.
Each time a database connection is established a check takes place if the current database
version is compatible with the application version. If not then the database update is started
automatically and the update log window is displayed (see figure).

The window shows a separate tab for each updated database (MySQL here). The table shows
the progress of the processed update actions and if they have been successful. If an update
step was successful then the column after Step displays a check symbol or an error symbol
otherwise.

If the database has changed all update steps are required to succeed since the
application expects a certain database version and it may show errors otherwise.
Unsuccessful update steps are often caused by missing permissions for the current database user.

You should check the current database permissions first if you encounter any update
errors and then try again by connecting to the database.

Additional Links
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• Database Menu

File Menu

• Import Measurements..

• Recently Opened

• Edit Files...

• Edit Network Files...

• Save

• Save As...

• Save As Network File...

• Database Backup

• Preferences

• Print

• Restart

• Exit

Import Measurements

Opens a dialog to choose one or multiple files with measurement data to be imported. By
default such files are stored by the program into the user's home directory under
.battman-1.6.x/devdata/, whenever there's a problem while saving device datasets into the
database. This way no measurement data is lost while the data import is possible at any time
after the failure.

After choosing files with measurement data another dialog is opened showing the overview of
recognized datasets. Besides the import file the number of contained datasets as well as the
target database is displayed. By clicking the Import button the import of all the listed files
begins. If you like to delete the successfully imported files afterwards please enable the Delete
files after successful import option.

The imported measurement data is listed by the Measurements tab found on the database
session presented by the session window. Depending on the number of datasets and the
connection speed the import may take a while and should not be interrupted.

Recently Opened

This submenu shows the files and network files which have been opened by the document
window for viewing or editing purposes. Here, a maximum of 10 entries are being displayed.
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You can open these files again by selecting the desired submenu entry. In order to clear the list
from time to time or due to data security concerns please select the last entry Reset.

Edit Files

Opens the file chooser dialog where you can select one or multiple files to be viewed or edited
by the document window. Currently the following file types are supported by this window which
means viewing or editing is possible for these types:

• Graphics files in the formats *.bmp, *.jpg, *.wbmp, *.png, *.gif (viewing only)

• Text files *.txt, *.log, *.asc, *.sig (viewing/editing)

• XML files *.xml (viewing/editing)

• Java properties *.conf, *.properties (viewing/editing)

For these file types arbitrary extensions may be configured in the preferences, an appropriate
editor is then opened automatically. In the file system window it is possible to open arbitrary file
formats with the integrated hex editor. Please select the Hexedit context menu (right mouse
button).

This function can also be called with the shortcut Ctrl+E (Windows) or Cmd+E (Mac).

Edit Network Files

Opens the network file chooser dialog where you can select one or multiple files to be viewed or
edited by the document window. Currently the following file types are supported by this window
which means viewing or editing is possible for these types:

• Graphics files in the formats *.bmp, *.jpg, *.wbmp, *.png, *.gif (viewing only)

• Text files *.txt, *.log, *.asc, *.sig (viewing/editing)

• XML files *.xml (viewing/editing)

• Java properties *.conf, *.properties (viewing/editing)

For these file types arbitrary extensions may be configured in the preferences, an appropriate
editor is then opened automatically. In the network file system window it is possible to open
arbitrary file formats with the integrated hex editor. Please select the Hexedit context menu
(right mouse button).

Save

The currently displayed file or network file within the documentwindow can be saved with this
function, if the content has been changed. This is always indicated by an asterisk (*) after the
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file name on the tab. If a file name is not known right now (e.g. after inserting content from the
clipboard), then a file selection dialog appears to be used for storage.

This function can also be called with the shortcut Ctrl+S (Windows) or Cmd+S (Mac) as well as
from the tool bar using a button.

Save As

For contents of the documentwindow to be saved into local files, please use the SaveAs
function. A file chooser dialog is displayed to specify a target file to save the data. If the file
already exists and the content has not already been saved into this file, a security dialog
appears, where you can cancel the saving.

Save As Network File

For contents of the documentwindow to be saved into network files, please use the SaveAs
Network File function. A file chooser dialog is displayed to specify a target file to save the data.
If the file already exists and the content has not already been saved into this file, a security
dialog appears, where you can cancel the saving.

If network files are being accessed the respective network connection must have been
established. In order to do so you can use the functions in the header area of the dialog. You
can create new connections with the Edit Connections menu.

Database Backup

The Battery Manager database should be backed up regularly in order to be able to restore
data in cases of server failures or due to accidentally deletions. Most database manufacturers
provide specialized tools for that which are capable of creating backups automatically on a
regular basis.

The databases supported by Battery Manager may be backed up additionally with the
Database Backup menu. The files created here may be used also to transfer from one
database into another database.

Please remember that the transfer of database backups into databases of different
types is only possible with the Professional Edition and the Enterprise Edition. The
Personal Edition is limited to restore data into the same (embedded) database.

• Create Backup: Saves the datasets into a local file

• Restore Backup: Loads the backup from a file and restores the datasets
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With Create Backup the backup creation wizard is called. In the first step Database
connection you can choose the database to be backed up, the connection must have been
established with the session window. In the second step Backup file format you may choose
between Plain XML and ZIP compressed archive. The ZIP archive is recommended since the
files are significantly smaller than the plain XML files. In the last step Target file the wizard
requests a file for the backup. Depending on the number of datasets and the connection speed
the backup may take a while after you have pressed the Finish button.

With Restore Backup the database contents may be restored from a backup file. The backup
restore wizard initially requests a target database (step Database connection), the connection
must have been established with the session window. In the seconds step Target file you may
choose a file from which the database shall be restored.

In the last step Check the wizard determines whether the data may be imported into the desired
database. To do this the application version must match, the database schema version must
match, the current edition is required to allow the transfer (see notice above), and the tables of
the target database need to be empty. If one of these necessary requirements is not satisfied
the dialog shows an appropriate hint. For example if the tables still contain data then the
datasets may be deleted using a link which opens the database management. This has to be
done manually in order to have the chance to create backups of the running database.

If all requirements are satisfied the database backup can be restored by clicking the Finish
button. Depending on the number of datasets and the connection speed the backup restore
may take a while and should not be interrupted.

While the database is restored from backup files the current datasets are deleted.

Please backup your database before the database tables are deleted during the backup restore.

Preferences

The program settings are managed with the Preferences menu. All file operations around the
preferences are located in the Preferences menu of the File menu together with the other file
functions.

• Save Preferences: Save preferences into configuration file(s)

• Import Preferences: Load previously exported preferences from a file

• Export Preferences: Save current preferences into a file of choice

With Save Preferences the current preferences of the program may be saved explicitely e.g.
after changes were applied. Each time the program is terminated the preferences are
automatically saved in the configuration file of the application. This file is located in the PC
user's home directory in .digester-1.6.x/config/digester.conf. Depending on the program
this directory contains additional configuration files like OpenPGP keystores which are saved
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automatically as well when the program terminates. If the program has to be stopped using the
Windows Task Manager then the preferences are not saved, so that your settings at the time of
interruption may be lost. After bigger changes to the configuration it makes sense to save the
preferences explicitely once with this menu function.

This function can also be called with the shortcut Ctrl+Alt+S (Windows) or Cmd+Alt+S (Mac).

With Import Preferences you can choose a file to load preferences which have stored using
the Export Preferences functionality previously. After these two functions have been called a
file chooser dialog is displayed where to select a configuration archive in ZIP format. If the file
does already exist a security dialog is shown where the action can be cancelled. Please keep in
mind, that you can only import such configuration archives that have been exported with exactly
the same program version. If this is not possible the program shows a special message.

The export functionality should be used regularly to create backups of the program
preferences. The exported archives should then be saved on secure media and carried
to secure locations. Import/export could also be used to transfer the preferences from
one PC to another or to restore the preferences for example if the operating system has
been re-installed.

Print

Many application parts like the session window provide a function to print lists. The button is
active whenever such a function is supported by the program. Depending on the program
additional print buttons may exist where additional options like portrait or landscape are
provided.

This function can also be called with the shortcut Ctrl+P (Windows) or Cmd+P (Mac).

The preferences provide a Printing section where to configure several options to control
printing like the paper size, resolution, and a default printer.

Restart

The program can be properly terminated and restarted with the Restart menu. This is possible
for both the installer versions as well as the Web Start versions of the software. When restarted
the current program state is being analyzed. Dialogs may be created e.g. if tasks are still being
executed and where the appropriate steps can be configured. Finally the program shows a
dialog where you must confirm the restart of the program (not the PC!). This dialog may be
opted out by setting the Do not show again flag so that the next restart can be executed
directly without being asked.
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Program restarts may be initiated by the program itself e.g. after the memory size has been
adjusted.

Exit

The program should be properly terminated after use, since certain data and preferences are
saved for the next run. If the program is stopped by the Windows Task Manager for example
your manuall applied settings may be lost and must be applied again the next time. When
restarted the current program state is being analyzed. Dialogs may be created e.g. if tasks are
still being executed and where the appropriate steps can be configured.

This function can also be called with the shortcut Ctrl+Q (Windows) or Cmd+Q (Mac).

Additional Links

• Session Window

• Document Window

• File System Window
• Network File System Window
• Preferences

Edit Menu

• Cut (Ctrl+X/Cmd+X): Delete files/directories, list entries etc.

• Copy (Ctrl+C/Cmd+C): Copy text, files, or network files in clipboard

• Paste (Ctrl+V/Cmd+V): Paste contents from clipboard

• Delete (Delt/Delt): Like Cut

• Rename: Give files/directories or network files new names

• Find (Ctrl+F/Cmd+F): Call the search functions e.g. of the file system window

This menu contains standard functions for the work with files, directories, network files, texts,
lists etc. The functions may vary depending on the active docking window. The cut function of
the file system window for example causes the selected files or directories to be deleted while
this function deletes the selected text in the active editor of the document window. These menu
entries are enabled if the functions are supported by the active docking window, deactivated
otherwise.

Some of the functions can also be called with shortcuts (Windows/Mac) or by clicking tool bar
buttons.
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Additional Links

• File System Window
• Network File System Window
• Document Window

• Tool Bar

Setup Menu

• Setup Wizard

• Language

• Look & Feel
• Fonts
• Memory

• View

• Web Start

• Preferences

Setup Wizard

This wizard can be used to configure the database and connected devices the first time the
application is started. Since this wizard simply calls the two other wizards device wizard und
database wizard sequentially we will not go into detail here.

Language

The user language can be very easily configured during installation via installer or using Web
Start so that the Battery Manager software already displays the desired language initially.
Especially on computer systems with multiple users it may be necessary that the software
supports multiple languages. While one user wants the English version, another user prefers
the German version. This is no problem because the language setting within the Battery
Manager software is stored on a per-user basis. You may also switch the language at runtime,
only a restart of the application is necessary in such cases.

• English (US): English language, United States (American English)

• German (DE): German language, Germany

To do so, please open the Language submenu and select the desired language. The current
language is grayed out and not selectable (here English). If you like to use English as your
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language then select the English (US) entry. Please note, that the languages are selectable
here only if the relevant language packs have been installed. If you want to make all supported
languages available for the computer users, then please select the Full Installation. When
installing the Battery Manager software via compressed archives then all available languages
are installed by default. If you use the Battery Manager software via Web Start, then you can
choose your favorite language by simply selecting the appropriate link on the Leisenfels
homepage. The menu for the Web Start version (see above) always shows all available
languages on the server. The required language pack will be automatically downloaded when
the language is changed.

Once you have selected a different language, the program prompts you to restart the
application (not the whole computer). A restart is possible with all program variants directly from
the menus. By clicking on Restart Now the application is terminated and then restarted. If it
does not work, please start the application as usual e.g. by double-clicking the desktop icon or
from the program group. You can use the new language when the software has been restarted.

Look & Feel

The Battery Manager software uses a standard look & feel based on the operating system and
therefore looks differently under Windows and let's say Linux. This makes sense since the
application integrates flawlessly into the current environment. If you do not like the default look
& feel then you can choose from an extensive list of additional look & feels. The Leisenfels
website shows s small set of available look & feels.

To change the look & feel please activate the Look & Feel menu. The current look & feel is
grayed out and not selectable. Please note, that the look & feels are provided only if the
components have been installed. If you want to make all supported look & feels available for the
computer users, then please select the Full Installation. When installing the Battery Manager
software via compressed archives then all available look & feels are installed by default. This is
also the case for the Web Start variants of the software.

Changing the look & feel does not require the application to be restarted, the new look & feel is
displayed immediately. When switching between different look & feels, it is possible that single
components are displayed unexpectedly. Then please restart the application (not the whole
computer) and the freshly initialized application components are displayed properly.

By activating the menu Show Overview... a dialog is opened. On the Look & Feels tab you
can see the list of currently installed look & feels with their respective short names. Right next to
the list you can find the available look & feel themes as well as the individual characteristics of
the selection. If you select a look & feel with the mouse then the available themes are
determined and displayed. The bottom right area shows the main properties of the selected look
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& feel including short name, description, and full class name. This status dialog can also be
opened with the help menu About Battery Manager.

Fonts

In order to improve the readability of the displayed fonts you can adjust the font sizes:

• Larger Fonts (Ctrl+Plus/Cmd+Plus): Increase font sizes by 10%

• Smaller Fonts (Ctrl+Minus/Cmd+Minus): Decrease font sizes by 10%

• Reset Font Size: Set font sizes back to default value (100%)

Some of the functions can also be called with shortcuts (Windows/Mac). In order to configure a
precise font size percentage please adjust the input field within the preferences.

Memory

Java programs are often deployed in professional environments and are subject to some
(reasonable) limitations on resource consumption. Thus, the amount of used memory cannot
grow infinitely, but the maximum must be specified before the application is started. This has
the advantage that the running computer programs cannot crash the system (important for 24/7
servers). This precaution, however, makes it necessary to determine how much memory may
be consumed (memory here always means the RAM). How much memory is currently
consumed by the application and how much more is possible, these values can be controlled
with the memory controller component on the right side of the main window status bar.

• Release Caches: Clear internal caches in order to increase available memory

• Memory Size: Adjust the maximum memory size with a dialog

• Collect Garbage: Free memory that is not longer needed

With the menu function Release Caches the Battery Manager software clears the currently
managed internal caches, if possible. For example this includes many of the displayed icons
and dialogs which are kept in memory for a certain period of time (normally 10 minutes). This is
efficient since the resources do not have to be reloaded again and again. After the configured
timeout the caches are automatically released then the total amount of available memory for the
program can be increased. You can use this function before complex calculations to free as
much memory as possible.

By default, the Battery Manager software is configured to consume a maximum of 256
megabytes (MB) of memory. Here the amount of memory that the Java environment itself
consumes must be added (under Windows about 35 megabytes). This amount of memory
should be sufficient for average checking and generating operations, however, you should
configure more memory if you plan to process entire disks or directory trees. While the
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algorithmic calculations require little memory, the result structures may require many hundreds
of thousands of objects being managed simultaneously.

In order to adjust the memory size for the programm in general please click on the Memory
Size item, a dialog is shown to adjust the memory. You now have the choice of a fixed value
from the list (e.g. 64, 128, 256 megabytes) or you can enter the desired value manually (e.g.
384). Values of less than 64 megabytes will not be accepted by the dialog. If you like to
increase the default value of 256 megabytes, please select one of the values 256 or 512. It
must not exceed the half of the physical memory since this can cause the operating system to
crash. If your computer for example is equipped with 1 gigabyte of memory (1024 megabytes)
then you should enter a maximum value of 512 megabytes.

Now you can confirm the dialog with the OK button to commit the maximum memory size. Then
another dialog is opened that prompts you to restart the program (not the whole computer). If
you select Cancel here then the previous memory size is not changed. Click Restart Now to
terminate the application which is then immediately restarted. If it does not work, please start
the application as usual e.g. with the desktop icon or from the program group.

If the amount of memory is too large, the application may not start! To reset the previous
value for installer versions please open the battman.vmoptions file in the application
installation directory with a text editor (e.g. WordPad under Windows) and then set the
value back to -Xmx256M (default). Start the application as usual and select a suitable
amount of memory as described above. For Web Start versions you can simply go to
the Leisenfels homepage and reinstall the software by clicking the appropriate hyperlink.
The application will then use the default memory size of 256MB.

Often large amounts of text or image data are loaded into the clipboard which may require
much memory. The clipboard can be cleared at any time by clicking the clipboard icon next to
the memory controller in the status bar and then by clicking the symbol with the blue recycle
icon. The amount of consumed memory shown by the memory controller will then be reduced.
The Collect Garbage function is automatically called in the background either at irregular
intervals and if the Java environment runs out of memory.

This function can also be called with the shortcut Ctrl+G (Windows) or Cmd+G (Mac).

View

• Tool Tips: Show little automatic windows with help texts for components

• Tool Bar: Show the tool bar at the top

• Status Bar: Show the bar for messages, progress, and memory at the bottom
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With the menu View you can turn certain GUI components on or off. The so-called tool tips are
the small help windows being shown after a certain time period when placing the mouse pointer
over a window component. Tool tips are enabled by default because new users can find useful
hints here. If you do not like tool tips to be shown just deselect the checkbox item named Tool
Tips.

If you like to save some place on the main window you can hide the tool bar (the row of icon
buttons on top of the main window). With the menu Tool Bar you can reactivate this component
at any time. The tool bar can also be hidden by using the context menu (right mouse button) on
the right side of the tool bar component next to the icons. Many of the menu functions can be
called by their corresponding context menus provided directly by the GUI components.

Like the tool bar also the status bar can be hidden. The status bar can be found at the bottom of
the main window where the above mentioned memory controller is positioned. With the menu
function Status Bar you can reactivate this component at any time. The status bar can also be
hidden by using the context menu (right mouse button) directly on the status bar component
(select the Hide Status Bar menu item). This context menu provides two additional menu items
to hide the memory controller and the time component separately.

Web Start

• Java Control Panel: Web Start application management of the Java environment

• Uninstall: Uninstall Web Start version, keep local configuration files

• Clean Uninstall: Uninstall and also delete local configuration files

The Battery Manager software can be installed locally via Installer or downloaded and started
from the Internet via Web Start. To support the work with the Web Start version the software
provides various menu functions. You can find these functions in the submenu Web Start.
Please note that all menu items shown here are only available within the Web Start versions
and disabled for the installer versions.

The Java Control Panel can be opened with the Java Control Panel menu item. The Java
executable javaws must by accessible from the execution path which is normally adjusted by the
Java installer automatically. Within the Java Control Panel you can list and remove currently
installed applications, view JNLP files, and much more.

With the menu function Uninstall you can remove the Web Start application from the Web Start
environment including resources from the local disk. If desktop icons have been installed during
Web Start installation these will also be removed here. The application of course cannot be
started after uninstallation and must then be installed again from the Leisenfels Internet server.
If you also want the configuration directory of the Battery Manager software be deleted on
uninstall please activate the menu Clean Uninstall. This allows the software to be quickly
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installed e.g. on a customer's computer and uninstalled after the work has been done without
leaving any files on the system (data security).

Please verify that the configuration directory has been successfully removed when
using the Clean Uninstall function since especially Windows systems permit
applications to remove files which are currently opened. For instance this is the case
for the Battery Manager log file.

Preferences

Here you' ll find the options to configure the program. For a detailed listing of the configurable
values please see the Preferences section.

The import/export of preferences as well as the function to explicitely save the settings is
implemented by the functions of the File menu.

Additional Links

• Preferences

• Shortcuts

• Tool Bar
• Status Bar

Devices Menu

• Device Wizard

• Edit Devices

• Open Custom Device

• Rescan Ports

Device Wizard

This dialog guides the user through the installation of a new device. Currently the Battery
Manager supports charging devices like Charge Manager 2010 and barcode readers like
Honeywell Voyager 9520 both of which are attached to the serial interfaces. In addition to that
Battery Manager provides support for custom devices on the LAN/WLAN like Gembird
EnerGenie (programmable power management units).

In the first step the wizard determines the available serial interfaces of the computer. The free
ports can then be selected. In the second step a device can be deposited. Since devices are
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stored into the database a database connection is required which must have been created
using the session window. A tab showing the devices is displayed by the wizard for each
connected database here.

Please choose an available device from the list (double-click). If no appropriate or free device is
available please add a new device directly from the list or copy an existing device.

Finally the wizard creates a new device window where additional settings may be applied. By
default separate windows are created for the devices which can then be positioned to the right
of the main window. The device windows may also be moved to the dock.

Edit Devices

The dialog to manage devices allows the creation and maintenance of devices in a connected
database. A database connection is required which must have been created using the session
window, a notice on the status bar is displayed otherwise.

The list in the figure shows the deposited device datasets shipped with the Battery Manager
software. Currently the Battery Manager supports charging devices like Charge Manager 2010
and barcode readers like Honeywell Voyager 9520 both of which are attached to the serial
interfaces. In addition to that, also devices without serial interface may be configured here (of
no fixed type) which cannot be displayed by the device window though. For example a
multimeter from METEX without serial connection is configured here which is used for manual
measurements of the battery voltage.
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For the details of the general function of the buttons and choosers please refer to the
description of the session window.

Open Custom Device

Besides the devices that are connected to serial computer ports (e.g. VOLTCRAFT chargers) a
new device type has been introduced: custom devices. Custom devices are arbitrary devices
typically connected over LAN or WLAN connections. Currently the Battery Manager provides
support for the Gembird EnerGenie EG-PM2-LAN, EnerGenie EG-PMS2-LAN, and EnerGenie
EG-PMS2-WLAN power management units. These devices may be used to turn on other
devices like chargers on program start and turn them off automatically if the program is exited.
This helps reducing unnecessary power consumption.
New custom devices may be added using the device wizard or the new "Open Custom Device"
menu. Like serial devices also custom devices may be used by their type only or may be
associated with an existing concrete device from a connected database.

Rescan Ports

The Rescan Ports menu may be used to find the serial ports of the computer. After the scan
the status bar prints a message with the number of free ports. This function is especially useful
also while the application is running to find temporarily attached USB serial ports. Typical port
names under Windows are COM1, COM2 etc.

For each detected port the menu displays an appropriate entry with which the visibility of the
associated device window can be controlled. If a port has not been configured yet or if a port
must not be used by Battery Manager then the menu item is deselected.

The scan functionality can also be called with the corresponding shortcut (Windows/Mac).

The easiest way to configure new devices is the device wizard. It is recommended to use this
dialog whenever possible for the configuration of serial ports, too.

Additional Links

• Device Window

• Session Window

• Preferences

• Tool Bar
• Shortcut
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Database Menu

• Database Wizard

• Analyze States of Charge

• Calculate Waste Prevention

• Edit Connections

• New Session
• Connect
• Disconnect

• Reconnect

• Start Embedded Database

• Stop Embedded Database

• Set/Change Password

• Users & Roles

• Manage Tables

• Manage Sequences

• Edit Client Data

Database Wizard

This dialog guides the user through the installation of a new database connection. Currently the
Battery Manager supports databases like Oracle, MySQL, and Apache Derby (embedded
database) which are normally provided by a server.

In the first step you can choose which database type to use. Here, the embedded database
shipped with the Battery Manager (Apache Derby) or an external database may be selected. A
new function here is to import connections from existing connection files where no manual
editing is necessary any longer. Please choose the appropriate option here, then specify a file
with connection data in the next step which has been e-mailed to you if you obtained a
Leisenfels database hosting package.

Please remember that multiple sessions with different database types (i.e. Oracle,

MySQL) are supported only by the Enterprise Edition. The Personal Edition allows the
use of the embedded database only while the Professional Edition is limited to
connections for one single database type.

If the embedded database has been chosen (default) the wizard navigates to the last page
since all necessary settings have already been configured by the program. The embedded
database is configured during the Battery Manager installation and has just to be started at this
point in most cases and is ready for work then. With the Create new session option the wizard
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creates a new session window tab for you once the dialog has been closed using the Finish
button.

If an external database has been chosen the database type like Oracle or MySQL is required
now. Below this chooser please specify a unique name for the new connection. This name later
appears as title of the session tab for this connection.

In the next step the wizard requests all parameters necessary for this connection of the desired
database type where the values strongly depend on the local configuration of your database.
The structure of this input form is the same as described by the input form for database
connections section below and shall not be discussed here redundantly.

Once all settings are done and Next is clicked the wizard switches over to the last page where
the connection is checked. With the Create new session option the wizard creates a new
session window tab for you once the dialog has been closed using the Finish button. If the
connection check has not been successful please move back using the Back button, modify the
unproper settings, and try again.

Analyze States of Charge

The menu Analyze States of Charge opens the dialog for analyzing the measurement data.
The post-measurement states of charge can be easily used to get an overview your secondary
battery's capacity over time. If a battery loses more and more of its nominal capacity then it
should be replaced by a fresh new battery. In addition to that it is now possible to check for
batteries under a certain capacity (e.g. <= 20%) from time to time which can then be charged
simultaneously. This saves time and costs and helps avoiding an uncontrolled failure of critical
battery-driven devices like smoke detectors. If such a battery is predicted to currently have only
let's say 20% of its nominal capacity left then it should be recharged or replaced.

For each measurement type (manual or series from device) the state of charge per
measurement can be calculated for the time right after the measurement. These percent
values are displayed by a special column found on the Measurements tab. In order to get
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reliable results one of the maintenance programs CHK (check), CYC (cycle), or ALV (alive)
must have been executed. Also the program must have terminated properly with a RDY (ready)
or TRI (trickle) status from the device. Also manually edited measurements are recognized as
long as the conditions mentioned above are being matched here, too.

This means that if you plan to calculate states of charge you must run one of the maintenance
programs CHK, CYC, or ALV for the batteries which is required to be logged completely into the
database until the RDY (ready) or TRI (trickle) status is reached. This is the basis for the
software to calculate the states of charge for the measurements or series after successful
charging program completion. The overview then gives a good impression of the battery
development over time.

Based on the calculations of the post-measurement states of charge the Battery Manager may
also calculate the estimated current states of charge. These percent values are displayed by
a special column found on the My Batteries tab. Here, two sequential measurements are
required which must have been logged the way as explained above. Here, the period of time
between the chargings together with the used capacity is transferred to the time period since
the latest charging. If the capacity usage is constant and the battery quality can be assumed
also being constant this allows for a pretty good prediction of the current battery capacity left.

Please keep in mind that the states of charge calculated by Battery Manager are subject to certain

inaccuracies. So the capacity usage for one and the same device may vary significantly e.g. when

deployed outside in different times of the year. Plus, factors like the battery age and the time

period between the chargings play a major role here.

Please use the calculated percent values only as indicators e.g. to avoid battery failures. The

calculated values must never be taken as precise predictions since a precise calculation is not

possible at all due to the factors mentioned before.

At the bottom of the dialog the list shows the overview of the states of charge calculated so far
as well as some base data for the respective batteries. In the top area you can see the time and
date that the analysis has been executed the last time as well as the connection data for the
database.

On the right side some options exist to control the analysis:

• Run analysis automatically for first session
• Run analysis automatically on measurement changes
• Include batteries in all lifecycle phases
• Only use batteries in the following phases (list)

Please enable the Run analysis automatically for first session option if you like to analyze
the complete list of states of charge every time you connect to the database the first time.
Typically this is the case when you start the software. If you better like to refresh only if

Battery Manager 1.6.3 User Manual - Database Menu

65 / 130



measurement data has been modified (e.g. after charging a battery or if multiple series have
been assembled) then please choose the Run analysis automatically on measurement
changes option (default). Both settings may be combined as well. If none of these settings is
activated then no automatic analysis will take place.

The Include batteries in all lifecycle phases option controls which batteries are being
analyzed. Here, all batteries from the database are used. If you like only batteries in certain
lifecycle phases be used (e.g. deployed, idle etc.) please choose the Only use batteries in the
following phases, then specify the desired phases afterwards with the Choose button.

The analysis may be started by clicking the Start Analysis button. Existing results from the
database may be deleted with the Reset button (prior confirmation required). The dialog can be
closed with Close.

If you like to analyze the state of charge for single batteries and independently of their lifecycle
phases, then please use the function with the same name provided by the My Batteries tab.
After selecting the desired batteries from the list the analysis is started using the context menu
(right mouse button) or the button with the percent symbol.

The state of charge analysis function may be called also from the tool bar by clicking a button
(percent symbol).

As mentioned above Battery Manager can filter batteries with certain states of charge. Please
navigate to the My Batteries tab. The combo chooser right next to Filter on top of the list
contains several preinstalled entries to list all batteries with less or equal 10%, 20% etc.

Calculate Waste Prevention

The newly integrated Database submenu named Reports & Statistics contains a new item
Calculate Waste Prevention. Like the function for the state of charge prediction also the waste
prevention functionality can be controlled with a special dialog.
When rechargeable batteries are being charged, a certain capacity amount is restored which
can be used by the deployed device again. If conventional primary batteries were used instead
of rechargeable batteries then these had to be replaced here. This means polluting the
environment with additional toxic waste.
If charging devices with programs like CHK (Check) or ALV (Alive) are used for recharging and
if the produced measurement data is recorded, then the amount of restored capacity may be
calculated. On the basis of average capacities and weights of primary batteries the software
calculates how many primary batteries with a certain total weight have been prevented. The
total weight can be set in relation to the overall weight of the rechargeables in the database.
The calculation results are displayed by a special button on the right side of the program's
tool bar.
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Please keep in mind that the waste prevention calculations made by Battery Manager do not

represent precise statistics since the measurements and series are subject to certain inaccuracies.

Especially the software uses average capacities and weights of primary batteries which do not

properly represent the real characteristics of the used primary and secondary batteries.

At the bottom of the dialog the list shows the overview of the waste prevention calculated so far
as well as some base data for the respective batteries. In the top area you can see the time and
date that the analysis has been executed the last time as well as the connection data for the
database.

On the right side some options exist to control the analysis:

• Run analysis automatically for first session
• Run analysis automatically on measurement changes
• Include batteries in all lifecycle phases
• Only use batteries in the following phases (list)

Please enable the Run analysis automatically for first session option if you like to analyze
the complete list of batteries every time you connect to the database the first time. Typically this
is the case when you start the software. If you better like to refresh only if measurement data
has been modified (e.g. after charging a battery or if multiple series have been assembled) then
please choose the Run analysis automatically on measurement changes option (default).
Both settings may be combined as well. If none of these settings is activated then no automatic
analysis will take place.

The Include batteries in all lifecycle phases option controls which batteries are being
analyzed. Here, all batteries from the database are used. If you like only batteries in certain
lifecycle phases be used (e.g. deployed, idle etc.) please choose the Only use batteries in the
following phases, then specify the desired phases afterwards with the Choose button.

The analysis may be started by clicking the Start Analysis button. Existing results from the
database may be deleted with the Reset button (prior confirmation required). The dialog can be
closed with Close.

If you like to analyze the waste prevention for single batteries and independently of their
lifecycle phases, then please use the function with the same name provided by the My
Batteries tab. After selecting the desired batteries from the list the analysis is started using the
context menu (right mouse button) or the button with the recycle symbol.

The waste prevention calculation may be called also from the tool bar by clicking a button
(recycle symbol).
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Edit Connections

The dialog for the management of database connections allows to create and maintain
connections with local or remote servers. On the left side of the dialog window new connections
can be created (plus symbol), existing connections can be deleted (red X), and selected
connections can be copied (symbol with double document). Connections may be imported from
files using the folder symbol, the associated save function is provided by the button to the right
showing the diskette symbol. The order of the connection items can be alphabetically or in the
order of creation. If the connections are shown as created (unordered) then the connections can
be sorted manually by moving the items up or down. Invalid connections due to invalid
configurations (e.g. because the used DBMS type is not supported) are shown with a stroke.
The tool tip shows a message.

In order to adjust the existing connections please select the entry in the list. The settings for this
connection are then displayed on the right side of the dialog. To check the current settings,
please click the Check button at the bottom. A special dialog is opened where a connection can
be established using the current settings. If the connection could not be established e.g. due to
a missing password an appropriate message is displayed. Sometimes the log file of the
software contains a hint why problems have occurred during connection tests (blocked/wrong
ports, wrong password etc.).
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Each connection can be given an appropriate name on the right side which can be adjusted
later. At the top you can select the DBMS to be used. The combobox shows the available types
like Oracle or MySQL. Depending on the selected DBMS the settings below may vary from
connection to connection.

The connection settings are devided into Server and Expert options. The server options
include:

• Server: Name or IP address of the server

• Port: Network port for the service like 3306 for MySQL, default is displayed

• Database: Name of the server database

• User: Name of the user for login (authentication)

• Password: Password of the user for login

• Schema Mapping: Mapping of application schemas to real schemas in the database

If user name and password are required please edit the data in the text fields. If the password
may be stored permanently so that is available for the next connects please enable the Save
password flag. If the password shall be used for the next connect only please disable the flag.
The password is not remembered then and has to be typed again the next time.

If your database has only one single schema for Battery Manager please modify the Database
Schema entries appropriately (double-click the teble cell, save with ENTER). Instead of
BATTMANDATA and BATTMANSYS you can set BATTMAN here for example. All tables are
then created together in this schema.
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The Expert options include:

• Retry to connect for max x seconds: Wait for slow dialin connections

• Automatically reconnect to dead peers: Re-establish connections when interrupted

• Keep connection alive every x seconds: Keep connection (ISDN/VPN)

• Send PING: Contact server, normally by sending ICMP PING

• Send SQL query: Contact server by querying the database

• Display settings before connection is established: Show dialog always

Once all settings shown by the dialog are as desired you can connect to the selected servers by
clicking the Connect button at the bottom of the dialog. If the selected connections are valid this
button is enabled, disabled otherwise. For each connection a separate tab with the name of the
connection will be displayed by the session window. With a click on the OK button the current
settings will only be saved without creating new connections.

The database connection management may be called also from the tool bar by clicking a
button. The preferences provide further settings for database connections, for example if
connections of the session window shall be restored or not when the program is restarted.

New Session
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With the New Session menu one can establish connections with configured server systems.
The currently selected connection within the tool bar is used for this. This selection is
automatically set to the current list selection each time the management dialog is closed so that
one can work directly with the connection that has been edited last. For each connection a
separate tab with the name of the connection will be displayed by the session window. If
configured for the connection the management dialog is presented here where you can edit
user name and password to login.

The function to create a new session may be called also from the tool bar by clicking a button.

Connect

The Connect menu is enabled if the session window is visible and the active connection tab is
disabled which means that currently there is not connection to the server. Together with the
Disconnect menu it is easily possible to keep connection tabs (sessions) permanently on the
screen (see preferences) while the connection is established on demand and disconnected
after use.

Disconnect

The Disconnect menu is enabled if the session window is visible and the active connection tab
is enabled which means that the tab is currently connected to the server. Together with the
Connect menu it is easily possible to keep connection tabs (sessions) permanently on the
screen (see preferences) while the connection is established on demand and disconnected
after use.

Reconnect

The Reconnect menu is enabled if the session window is visible and the active connection tab
is enabled which means that the tab is currently connected to the server. If the menu is called
the user is asked for user name and password so that the connection can be established for a
different database user.

Start Embedded Database

The embedded database shipped with Battery Manager may be started and stopped directly
from the running application. A separate program does not exist to do this. Depending on the
current state a symbol is displayed by the program status bar where the switch between the
states on/off may be performed directly.
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The final state of the embedded database (on/off) will be automatically restored the next time
the program is started.

Stop Embedded Database

The embedded database shipped with Battery Manager may be started and stopped directly
from the running application. A separate program does not exist to do this. Depending on the
current state a symbol is displayed by the program status bar where the switch between the
states on/off may be performed directly. Active sessions for the embedded database in the
session window will be automatically deactivated when the database gets stopped.

The final state of the embedded database (on/off) will be automatically restored the next time
the program is started.

Set/Change Password

For external databases it is required that users login using the deposited passwords. In order to
reach a maximum of security passwords should be changed from time to time. This may be
done by administrators using the appropriate database tools or by the users themselves. This
task may be done by calling the Set/Change Password menu.

It is required that the current/old password is specified first, then the new password must be
edited twice in order to avoid errors here. Once the password has been changed successfully
the current connection is reconnected automatically based on the new settings. If the password
for an external database is "changeme" then the user is automatically asked for a password
change if a new session is created. This automatism allows for an easy first login and ensures
that simple user passwords are changed to more secure values.

By default no password is set for the embedded database so that authentication with password
is not necessary. If the database access shall be restricted a password may be deposited using
a dialog here. This password has to be specified each time a new connection is established
later. An existing password may be deactivated by deleting the password (leave the input fields
empty).

User & Roles

Like other database applications also Battery Manager now provides support for user roles. A
role is a special user group with specific access permissions for the software functions.
Currently the database users can be assigned the following roles:

• Administrator
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• User (read-write)

• User (read-only)

An administrator may add arbitrary users for the current database. The login depends on the
user name each user logs into the database. Each database user can be assigned to one single
role as listed above. If there are no roles defined by the database then each user is treated as
an administrator with full access to the database. If at least one user has been assigned a role
then the defined users and roles are automatically activated. While administrators have full
access to database functions, read-only users may only view datasets (no write access).

Users (read-write) have full access to the database functions except for the backup routines
(create/restore), the administration of users and roles, as well as the database table
management. These functions are only allowed for administrators and normally not needed by
normal users working with the database. Users (read-only) are more restricted than read-write
users: only viewing is allowed for the database data. For example read-only users are not
allowed to store or import measurements into the database or to edit datasets using the various
forms. This role is useful for users like trainees who learn to use the Battery Manager software
and are not allowed to apply any changes to the database.

The new role concept is used for external databases like Oracle or MySQL only, not for the
embedded database since this has only one single user which is always an administrator.

Manage Tables

A dialog is displayed where the datasets in the database tables of the active session in the
session window are listed. Here you can delete all datasets using the Clear Tables button. This
is necessary for example before backups may be restored (see section Database Backup).

Please backup your database before the database tables are deleted with this function. The

data will be lost and may not be restored!

Manage Sequences

A dialog is displayed where all sequences in the database of the active session in the session
window are listed. Here you can repair defective sequences using the Repair Sequences
button. This is necessary for example after backups have been restored (see section Database
Backup) where invalid sequences were generated. This may lead to error messages displayed
by the program that new datasets cannot be inserted e.g. for batteries.

It is recommended to backup your database prior to executing this repair function. In the case

of errors during the repair then it is possible to restore the data at least to the previous
state.
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Edit Client Data

Each license for the Battery Manager software contains pieces of information about the licensee
(client). In order to associate each database connection with a client, parts of this information is
stored also into the database.

If you have registered a new license please create a connection to your database in the session
window and call the Edit Client Data menu item. Then choose a client from the license with the
Client combobox to be used for this database. You can adjust the licensee data in the input
fields below to your needs. For example some of these values are used for printing.

Additional Links

• Device Window

• Session Window

• Preferences

• Tool Bar
• Shortcut

Table Menu

• Add (plus symbol): Starts creating a new dataset

• Edit (pen symbol): Opens the dataset for editing

• View (glasses symbol): Opens the dataset for viewing (read-only)

• Copy (document symbol): Copies the dataset with new id, fields are transferred

• Reactivate (green dot): Sets the "Active" status, dataset is used

• Deactivate (grey dot): Sets the "Inactive" status, dataset is not used

• Move to Trash (recycling symbol): Sets the "Deleted" status, dataset is not used

• Delete (red X): Deletes the dataset finally, only possible from status deleted/trash

• Refresh List (double arrow symbol): Loads the datasets from the database again

• Print Portrait: Prints the list in portrait orientation

• Print Landscape: Prints the list in landscape orientation

This menu provides functions for the work with lists displayed by the session window. The
functions may vary depending on the active docking window and depending on the selected
items in the list. These menu entries are enabled if the functions are supported by the active
docking window, deactivated otherwise.
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The functions described here are also supported by the context menu (right mouse button) of
the list shown by the session window.

Additional Links

• Session Window
• Tool Bar

Network Menu

• Edit Connections

• New Session
• Connect
• Disconnect

• Clear Pool

Please keep in mind that the network functionality is not supported by the Personal
Edition.

The dialog for the management of network connections allows to create and maintain
connections with local or remote servers. On the left side of the dialog window new connections
can be created (plus symbol), existing connections can be deleted (red X), and selected
connections can be copied (symbol with double document). The order of the connection items
can be alphabetically or in the order of creation. If the connections are shown as created
(unordered) then the connections can be sorted manually by moving the items up or down.
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Invalid connections due to invalid configurations (e.g. because the used protocol is not
supported) are shown with a stroke. The tool tip shows a message.

In order to adjust the existing connections please select the entry in the list. The settings for this
connection are then displayed on the right side of the dialog. To check the current settings,
please click the Check button at the bottom. A special dialog is opened where a connection can
be established using the current settings. Please let the details be shown to see all messages.
Is the connection test successful, the dialog lists the capabilities of the connected file system. If
the connection could not be established e.g. due to a missing password an appropriate
message is displayed. Sometimes the log file of the software contains a hint why problems have
occurred during connection tests (blocked/wrong ports, wrong password etc.). In addition to the
connection check you can open the network file chooser dialog in order to test the selected
connection.

The network protocols must have been installed in order to be listed here. When in
doubt please choose the Full Installation for the installer.

Each connection can be given an appropriate name on the right side which can be adjusted
later. At the top you can select the network Protocol to be used for the data exchange with the
server. The combobox shows the available protocols like FTP or SFTP. The network protocols
must have been installed in order to be listed here. This can be done for the installation with
installer or with Web Start. A separate installation of specialized operating system drivers or
similar is not required. Depending on the selected protocol the settings below may vary from
connection to connection.

The connection settings are devided into Server and Expert options. The server options
include:

• Server: Name or IP address of the server

• Port: Network port for the service like 22 for SFTP, default is displayed

• Path: Access path on the server

• User: Name of the user for login (authentication)

• Password: Password of the user for login

• URI: Overall address for the server access consisting of the other fields

You can set a directory on the server as path which can be accessed by the configured user. If
the user bobby logs in to a FTP server and the home directory of the user is /home/bobby, then
set / to access the directory directly or /temp to list the subdirectory /home/bobby/temp. Create
links on the server i norder to access the root directory of the system if this is allowed for the
user. Depending on the server system the access rules configured on this system are valid also
for the network connection so that the access to files and directories is secure.
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If user name and password are required please edit the data in the text fields. If the password
may be stored permanently so that is available for the next connects please enable the Save
password flag. If the password shall be used for the next connect only please disable the flag.
The password is not remembered then and has to be typed again the next time. If you like to
edit user name and password each time a connection is established (not remembered) then use
the expert option Display settings before connection is established.

The input field for the URI (Uniform Resource Identifier) combines all entries of the other
components for this connection. You may either fill out the single fields or alternatively edit the
overall URI, the other fields are updated appropriately.

A URI must apply to the follwing scheme:

[protocol]://[username[:password]@]hostname[:port][absolute-path]

Examples of valid URIs are as follows:

ftp://kernel.org/pub/

ftp://root@ftp.mycompany.com/media/hdd/movie

sftp://bobby@mycompany.com :22/Temp

The configured password is not shown as part of the URI but used only internally in
order to avoid misuse and spying.

The Expert options include:
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• Retry to connect for max x seconds: Wait for slow dialin connections

• Automatically reconnect to dead peers: Re-establish connections when interrupted

• Keep connection alive every x seconds: Keep connection (ISDN/VPN)

• Send PING: Contact server, normally by sending ICMP PING

• Resolve server URI: Contact server by listing the access path

• Display settings before connection is established: Show dialog always

• File system encoding: Charset for the file names on the server-side

Once all settings shown by the dialog are as desired you can connect to the selected servers by
clicking the Connect button at the bottom of the dialog. If the selected connections are valid this
button is enabled, disabled otherwise. For each connection a separate tab with the name of the
connection will be displayed by the network file system window. With a click on the OK button
the current settings will only be saved without creating new connections.

The configured connections are used program-wide, which means that these connections are
provided by the network file chooser dialog and by the sync wizard for example. If
files/directories on remote servers are synchronized it makes sense to deposit user name and
password for the connections, if these functions are called from the command-line or from build
scripts.

The network connection management may be called also from the tool bar by clicking a button.
The preferences provide further settings for network connections, for example if connections of
the network file system window shall be restored or not when the program is restarted.

New Session

With the New Session menu one can establish connections with configured server systems.
The currently selected connection within the tool bar is used for this. This selection is
automatically set to the current list selection each time the management dialog is closed so that
one can work directly with the connection that has been edited last. For each connection a
separate tab with the name of the connection will be displayed by the network file system
window. If configured for the connection the management dialog is presented here where you
can edit user name and password to login.

The function to create a new session may be called also from the tool bar by clicking a button.

Connect

The Connect menu is enabled if the network file system window is visible and the active
connection tab is disabled which means that currently there is not connection to the server.
Together with the Disconnect menu it is easily possible to keep connection tabs (sessions)
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permanently on the screen (see preferences) while the connection is established on demand
and disconnected after use.

Disconnect

The Disconnect menu is enabled if the network file system window is visible and the active
connection tab is enabled which means that the tab is currently connected to the server.
Together with the Connect menu it is easily possible to keep connection tabs (sessions)
permanently on the screen (see preferences) while the connection is established on demand
and disconnected after use.

Clear Pool

The Clear Pool menu may be called to free memory consumed by re-used network
connections. Connection recycling is an optimization to limit the costs produced by new network
connections. Connection pools are managed for example for stateful protocols like FTP and
SFTP.

Additional Links

• Preferences

• Tool Bar
• Output Window

• Network File System Window

Window Menu

• Docking Windows

• Screen Shot
• Resolutions
• Reset Windows
• Close Tab

• Hide

• Refresh

Docking Windows

The docking windows in the main display area are the key components of the Battery
Manager software. Using the buttons at the top, bottom, left, and right sides along the edges of
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the main window, the docking windows can be made visible or invisible. Which docking
windows are displayed at all can be configured with the Docking Windows menu. Depending
on the edition, single or multiple windows can be missing, for example the generate window is
not available in the Basic Edition.

Each docking window can be configured individually so that you can easily make those
windows visible that are relevant for your daily work. In order to display a docking window, the
checkbox menu entry for the docking window must be selected. If the checkbox is disabled, the
window is not visible within the side bars. Some of the docking windows are shown
automatically by the application when needed. For example, this is performed for the search
results docking window.

Screen Shot

The Battery Manager software provides various functions to take screen shots to be saved as
files or to be printed. This functionality is useful e.g. when the Leisenfels support is contacted,
since certain behavior of the software or error conditions can be documented effectively. Any
support request to Leisenfels should be as precise as possible and in some cases a screen
shot attached can be much more informative than a textual description. With the Screen Shot
menu you can either open the capture tool dialog or take screen shots with the available
sub-menus directly.

• This Window: Print or save main window or copy to clipboard

• Full Screen: Print or save full screen or copy to clipboard

• Capture Tool: Show dialog and capture windows after timeout

Please note, that screen shots can contain sensitive information! Check the visible data
carefully before giving away to other persons. In some environments like hospitals a
higher security level may be required.

For the print function a printer is required which must be supported by the operating system
(e.g. Windows print service). The available printers of the operating system are being presented
by the dialog. The page format is configured automatically for the screen shot to fit on the page.
Alternatively you can save the screen shots as graphics files. You will be prompted to specify a
target file when the dialog is opened. If the file already exists a dialog is shown. Currently
supported graphics formats are BMP, JPG, WBMP, PNG, and GIF.
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By activating the Capture Tool sub-menu a special dialog is opened. This special tool is
independent of the Battery Manager main window and can thus be positioned anywhere on the
screen. On the left side of the dialog you can see numerous buttons. The first three buttons can
be used to produce a screen shot of a single window of the Battery Manager software, to
capture the entire screen, or to take a full screen shot after a timeout. To capture a single
window just click the top button and then activate the desired window of the Battery Manager
application. Please note, that this only works for the windows of the Battery Manager application
while the windows of other programs cannot be captured currently. The captured image data is
then displayed by the preview area of the capture dialog (see illustration). The Hide Dialog flag
in the context menu of the timeout button can be set if the tool dialog itself shall not be visible
on the photo.

If you like to take a screen shot of the entire screen so that all visible windows are captured,
please click the second button from the top (monitor icon). Alternatively you can take a full
screen shot after a certain timeout (e.g. 5 seconds). This function is useful to capture context
menues which are opened right before the screen shot to be on the photo. The timeout value
(default: 5 seconds) can be adjusted using the context menu (right mouse button) directly on
the stop watch symbol (1 to 60 seconds). With the X button you can remove the image data
from the preview since this saves significant amounts of memory. This could be done whenever
you finished working with the capture tool.

The captured images can now be processed in various ways. The Battery Manager software
can directly print the image on paper or save the data into files. Click on the printer icon to print
the image on a local printer. This function uses the default print service of the operating system.
Under Windows, the well-known Windows print dialog is opened. Usually the default printer is
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already selected so that the image can be directly printed on paper. It depends on your printer
configuration whether the screen shot is printed in color or just black and white for example.

With the floppy disk icon you can save the captured image data into files. Currently the file
formats BMP, JPG, WBMP, PNG, and GIF are available. Of course you can store the images in
various formats in multiple steps. The generated files can then be used for e-mail attachments
or opened with image editing programs such as Gimp. The following figure shows the file
selection dialog which is displayed after clicking on the floppy disk icon and where you can
specify the filename and format. If you like the image data be available for other applications
with access to the system clipboard, you can click the clipboard button. This loads the image
data into the clipboard of the operating system if supported (e.g. under Windows). The popular
image editing programs are able to process such data.

The capture tool can also be opened with a shortcut (Windows/Mac).

Resolutions

In order to set standardized dimensions of the main window several submenues of the
Resolutions menu exist. For example you can set the size 1024 x 768 pixels (XGA) here.

Reset Windows

You can call this function to get the docking windows back to their default positions when the
program was started the first time. This may be required if a windowshas been moved
accidentally from lieft to right and alike. Before the resetting takes place a dialog is displayed
which can still be canceled. The reset includes the window sizes, positions in the dock, as well
as the window modes (pinnded, unpinned etc.) which are reset to the initial values. The current
settings will be lost. The options of the docking windows (e.g. the templates of the generate
window) are not influenced by the reset.

During reset the docking windows are closed once and then reopened where positions, sizes
etc. are then adjusted with the values as if the program is started the first time.

Close Tab

The Close Tab menu can be called in order to close the active tab within a docking window.
This is only possible for some docking windows like the document window. The function is
executed for the active tab of the window (e.g. the shown document). The other tabs are not
influenced by this function, but may be closed also by calling this function multiple times.
Depending on the docking window special dialogs or messages may be displayed if for example
a modified document should be saved before it is closed.
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This function can also be called with a shortcut (Windows/Mac) if the active docking window
supports it. If not, the Close Tab menu is not clickable.

Hide

Docking windows can be hidden always if a docking windows has been activated to
receive input. The docking window then shows a special header as an indication (e.g. different
color).

This function can also be called with the corresponding shortcut (Windows/Mac).

This function is useful in order to make displayed docking windows invisible quickly for instance
if critical data like passphrases are currently being shown which should not be seen by other
persons. If a docking window is hidden then the previously active window becomes visible again
and so on. By calling this function multiple times all docking windows are made invisible. If a
docking window is being shown exlusively it will be hidden and the exclusive display of this
window ends.

Refresh

The Refresh menu allows to update the active docking window. The exact function may vary
depending on the type of the docking window. In the case of the file system window and the
network file system window the current directory will be read and listed again.

This function can also be called with the corresponding shortcut (Windows/Mac) if supported by
the active docking window. If not the Refresh menu is nicht clickable.

Additional Links

• Docking Windows

• Tool Bar

• Document Window
• File System Window

• Network File System Window

Help Menu

• Help

• Help Topics
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• Manual (PDF)
• Release Notes
• Check for Updates

• Send Status Report

• Product Homepage

• Buy License

• Register

• About Battery Manager

Help

This menu opens the help system appropriately for the active docking window or the current
program state. The possible entry positions are depending on the active docking window. If the
help is not possible for the current context then the menu is disabled. Then please call the Help
Topics menu instead and search for a pattern of interest.

The context-sensitive help can also be called with the corresponding shortcut (Windows/Mac) or
from the tool bar with a button.

Help Topics

The help system in JavaHelp format is part of the Battery Manager software and can be opened
directly from the running application. It is particularly suitable for fast lookup. The convenient
search function allows to search the contents for keywords or even parts of keywords. The help
system can be displayed by activating the Help Topics menu. Alternatively you can press the
F1 key which opens a special dialog with the following tabs:

• Table of Contents: List of chapters and sections of the help system

• Find: Search for pattern and sub-patterns in the whole text

• Favorites: Bookmarks with frequently used text positions

The first tab Table of Contents lists the chapters and sections of the help system. Normally,
there is already a start page selected, so that the viewing area initially shows some text. If the
help system is called from certain positions of the program, the display will navigate directly to
the associated section (context help).

To search the full text of the help system, go to the Find tab (magnifying glass icon) and enter a
search term where also parts of terms are allowed. When committed with ENTER, the search is
started and the find results are listed. By selecting a matching list entry with the mouse, you can
view the text in the text area to the right.
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The Favorites tab finally allows to store help page references permanently, so that such
references are directly available the next time the help system is opened. To store a favorite
text page from the help system, please select a page from the table of contents or from the find
tab so that the text content is displayed by the text area. Then click on the Add to Favorites
button with the same symbol as the Favorites tab. You can find this button in the tool bar of the
help system window (the slightly larger symbols). The added text page then appears on the
Favorites tab and is also available the next time the help system is opened.

Within the tool bar there are some more buttons to navigate Back and Next as you probably
already know from your Internet browser. You can click the printer icon to print the currently
displayed text page on paper.

Please note, that a printer is needed here which must be configured on the operating system
level. In order to adjust the size of the help system window for your computer system, you can
drag the divider between the list area on the left and the text area with the mouse.

In addition to the help system a printable manual in PDF format is shipped with the Battery
Manager software.

Manual (PDF)

In addition to the help system the Battery Manager software also provides a printable manual in
PDF format. You can view the PDF manual by activating the menu Manual (PDF). If there is a
PDF viewer such as Acrobat Reader installed on the computer, it will be automatically
executed. If no window shows up at this point, the system probably lacks a suitable viewer for
PDF files. Please install either an appropriate program to display PDF files and repeat the
above steps, or use the help system instead which can be directly opened from the Battery
Manager software. The Battery Manager software does not contain any viewer for PDF files.

The PDF manual is available for the Web Start versions of the software as well as for the
installer versions, provided that this component has been installed. More information about
installing the PDF manual can be found in section Installer for Windows. You can view the PDF
manual for an installed version also by clicking the special symbols within the program group for
the Battery Manager software, provided that the program links have been created during the
installation process.

From the Web Start versions, the PDF manual can be exclusively viewed by activating the
Manual (PDF) menu which first of all downloads the PDF file from the Leisenfels web server to
the configuration directory within the user's home directory. The next time you call the PDF
manual, this file is already available and does not need to be downloaded again.

Release Notes
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To find out about the features of the available Battery Manager versions, the Leisenfels web
server is available around the clock. The software itself also provides so-called release notes.
While the information for the currently used version is always available chances are good that
you can find the release notes of older versions here as well. Please activate the Release
Notes menu, so that a special dialog is displayed.

You can find the list of included program versions at the top left corner with the currently
running version being selected by default. If you like to view the release notes for an older
version, please select the corresponding entry in the list. The available notes for the selected
program version are displayed by the list on the right side. The entry symbols represent the
nature of the applied changes to the program version (e.g. new functionality, performance
enhancement etc.). In addition to the title of the note the table shows the date when the entry
has been deposited by the author. If you select a certain note from the list, the details for the
note are being displayed by the text area at the bottom of the dialog.

The top right corner of the text area may show hyperlinks to be clicked directly with the mouse.
For example, the links let you browse further information from the Internet or from the
application help system. The target addresses of the links are displayed as tooltips if the mouse
is crossing for a while. You can filter the available notes by type, category, and edition. Possible
change types are New feature, Enhancedfunctionality , Fixed bug, Security issue solved, and
Miscellaneous change. The categories are program specific, currently there are entries such as
Graphical User Interface and Digest generation available. Notes may also belong to multiple
categories. The edition filter allows you to display only the notes specific for one of the available
editions.

Check for Updates

In order to keep the Battery Manager software up-to-date, the software provides a special
dialog. Here you can explicitely check for newer versions as well as configure automatic update
checks performed in regular intervals. The figure shows the Check for Updates menu which
opens the dialog shown below. This is the well-known information dialog providing relevant
status data for the running application. The update information can be found on the Updates
tab.

Please note, that an Internet connection is required to load update information from
the Leisenfels download server.

When you call the status dialog via the Check for Updates menu it will immediately attempt to
connect to the Leisenfels Internet server. If you have no working internet connection then the
update connection will fail and no update information is displayed. If the update server can be
reached, a request is sent including the current program version as well as the unique license
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ID. The server responds based on the request by transmitting a data record which may contain
a list of available newer program versions. A special hint message is displayed by the dialog if
the currently used version has not yet been replaced by a newer version or if the license is
invalid (e.g. expired).

In the example, the request is generated by the installed program version 1.6.2 and the newer
version 1.6.3 Build 229 is available on the server. In addition to the exact program version, the
update list of the dialog shows the date of publishing for the update versions. The Update
column indicates the type of update, if it is a newer major version, a newer Java version, a
newer minor version, or a newer build version. The table shows examples for the different types
of updates for the Battery Manager software based on the following scheme:

[Hauptversion].[Java-Version].[Mini-Version] Build [Build-Version]

The major version starts with 1 and is incremented for each further major version. New major
versions are published when the software has changed fundamentally. Commercial licenses are
usually valid for a specific major version so that updating to another major version may not be
possible.

The Java version in the second position of a typical program version denotes the minimum
required Java version. The first Battery Manager versions are based on Java 1.6, so the
program versions are 1.6.2, 1.6.3, and so on. By adding the Java version to the scheme it is
possible to publish multiple versions within a major version for example for Java 1.5 and Java
1.6. Please keep in mind that a suitable Java runtime environment is required for such updates
at least for the Web Start versions. Some of the installer-based installation archives already
include an appropriate Java environment already.

Update Type Short Example for Version Change

Major version Major 1.6.3 to 2.6.1

Java version Java 1.5.4 to 1.6.1

Minor version Minor 1.6.2 to 1.6.3

Build version Build 1.6.2 Build 184 to 1.6.2 Build 223

The most common update type is the minor version change, since updates usually replace
older versions of the same major version including minor enhancements and bug fixes. Such
update versions can usually be used with an existing license. Both the installer and the Web
Start variants may be installed simultaneously so that you can safely testdrive a new version
prior to production use. Build version updates are only relevant for the development of the
software and will not be available for end-users.
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In order to avoid problems during the update process, please always check the latest release
notes for the respective version at the Leisenfels website first. You can do this comfortably by
clicking the hyperlinks shown by the update list of the software. These links are provided
directly by the update server depending on the program and allows you to directly navigate to
the appropriate area of the Leisenfels homepage. By clicking the links, your default web
browser is opened. The above mentioned dialog requests update information from the server
while the update packages themselves are not downloaded here. Thus you always have the full
control over the update process for your software.

If you are using an installer-based variant the installed version should be uninstalled prior to the
installation of the update version. If you are using the Web Start version of the Battery Manager
software, it is possible to let Web Start care for the automatic updating or you can update your
software manually by installing a fixed program version. For detailed information about the
available Web Start versions of the software and the update techniques see section Web Start.

By clicking the Check Now button you can always check explicitely for available updates. If you
like to query the update server automatically on a regular basis, then you should activate the
Auto-check option shown by the dialog. Here you can configure the time intervals between the
update requests. Currently, queries can be generated On every start, Daily, Weekly, or
Monthly. The Battery Manager software will automatically contact the update server and keep
you informed about available updates by displaying a special icon in the status bar. By clicking
this icon, the dialog is opened where you can view the list of available updates.

Send Status Report

The Send Status Report menu is only enabled if your license includes a commercially
available Premium Support option. This option is transported within the license key and
activated by the software when such a license is registered. The menu Send Status Report is
then enabled and can be selected.
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If the menu was called it may take a few seconds without any reaction by the program. Please
wait until the dialog is opened or a status message is displayed by the program. If only a
minimum of free memory is available please deactivate memory-consuming elements of the
status reports like screen shots from within the preferences before you call the status report
function.

The status report functionality currently is reserved for customers with
Premium Support option.

A status report consists of different pieces of information collected by the running program and
is transferred encrypted either directly to the Leisenfels support team or saved as a local file.
Saving as file becomes necessary if no Internet connection is available. The export file may
then be sent for example as an e-mail attachment from a PC with Internet connection to the
Leisenfels support for further analysis. The contained data is handled confidentially and only in
the way it is described in the license agreement (e.g. for analyzing errors).

Battery Manager 1.6.3 User Manual - Help Menu

89 / 130



Currently the following information can be sent with a status report:

• Messages: Program messages or own remarks as text

• Attachments: Program resources or own additional files

• License: Identification data about the current license

• Log Files: File with program output to be analyzed for errors

• Status Info: General information about the running program

• Screen Shots: Photos of the main window and the whole screen

The status report parts to be finally transferred may be configured in detail. If you like elements
like screen shots not being transferred you may opt out this feature within the preferences. In
addition to that any data elements presented by the dialog may be deselected or closed so that
these data report parts are not transferred or stored. The transferred or save status reports are
encrypted to avoid unwanted access.

The dialog to send status report on the left side shows the button Add Message to create a
new message, where the text could be typed like an e-mail. Please write messages either in
German or English, other languages are currently not supported. If you like additional files be
attached to the status report (like sketches, ZIP archives etc.) then please click the Attach
button and choose one or multiple files. Please keep in mind that the overall size of a status
report is limited, the program warns if this maximum size will be exceeded.

Below the buttons on the left you can see the collapsible areas representing the report parts
each. With the little buttons above the collapsibles you can deselect all, select all, expand all, or
collapse all parts. With the context menu of the collapsibles (right mouse button) you may select
or deselect the elements within the parts.

In the preview area on the right you can see the previews for the contained information as it is
seen later by the support team. The upper tabs each represent the collapsible elements on the
left side where at least one element must be selected in order to see the tab on the right. With
the red X you may close the tabs on the right so that that the associated data is not transferred.
The tabs at the bottom each represent the flags as shown by the expanded collapsibles on the
left side. Also these tabs may be closed in order to ignore the associated data for the final
transfer.

In order to send the status report please click on the Submit button. The program then tries to
establish a connection to the Leisenfels server on the Internet. During transfer the progress is
shown by a special dialog, you may do the transfer in the background like other tasks or cancel
the transfer. If the transfer was successful then an appropriate message is displayed.

If the report could not be sent another dialog is displayed where you can store the status report
as a local file. You can sent the stored report attached to an e-mail to our support team from a
PC with Internet connection or at a later time. If you generally like the status report sent via
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e-mail then click the Save button where you are prompted to specify an export file. If this file
does already exist a message is displayed.

In order to save memory, the preview for the scheduled data may be switched off (golden
symbol next to Cancel).

Product Homepage

After selecting the Product Homepage menu you will be navigated to the Battery Manager
pages on the Leisenfels Internet site. To do this your default Internet browser will be started and
the page will be preselected. If nothing happens probably no default Internet browser is
configured on your PC.

Please note, that an Internet connection is required to access the Leisenfels homepage.

Buy License

After selecting the Buy License menu you will be navigated to the Leisenfels shop on the
Internet. To do this your default Internet browser will be started and the page will be
preselected. If nothing happens probably no default Internet browser is configured on your PC.

Please note, that an Internet connection is required to access the Leisenfels homepage.

Register

To deploy the Battery Manager software, a commercial license must be obtained. You can find
the available product licenses and terms of use on the Leisenfels website. The software can be
licensed as a Single-User License where the Battery Manager software can be used by a single
person also on multiple computers. On first start or after selecting the Register menu
the Battery Manager software shows a dialog where you are prompted to specify a valid license
key. Here you can see the following tabs:

• License Key: Text with encrypted license key from file

• Info: Information about the license like type, ID, validities

• Features: Active options for the software like Premium Support

• Licensee: Data about the licensee (customer)

• Licensor: Date about the licensor (Leisenfels)

• Agreement: Binding license agreement text for customer and Leisenfels
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You can now specify a license key in several ways. If you have already purchased a license or
started an evaluation, you have received an e-mail with the associated license key in the form
of a text fragment or as a file attachment.

License files usually are named like license-DIGEST16BESU-LF-00001267.txt. Please save this
file on your hard disk or copy the text fragment from the e-mail to the clipboard of your operating
system. Under Windows this can be done by selecting the text with the mouse and pressing the
key combination Ctrl+C. Then switch to the registration dialog and either insert the copied text
(under Windows by pressing the key combination Ctrl+V) or select the license file by clicking
the File button so that the license key is inserted into the text area of the dialog. Once the
Register button becomes active, please click on this button.

The license will then be decrypted and verified. If the license is valid for the current version, the
license details are displayed by the other tabs Info, Licensee, Licensor, and Agreement.
Please read the license details carefully. In particular you should read the license agreement
carefully because this provides the legal framework for the use of the software. If you confirm
the dialog with the OK button, another dialog will be opened prompting you to accept the
license agreement.

If you do not accept, the dialog is closed and the Battery Manager software is terminated
because no valid license key is configured. If you do accept the agreement, the dialog is closed
and you can use the software from now on. The license will be deposited within the
configuration directory and automatically loaded and checked the next time the application is
started. If the deposited license key is invalid e.g. because the license has expired you will have
to set a valid license as described above.

If you want the Battery Manager software to be improved in the future, we ask you to
obtain valid licenses for each deployment of the software and to make sure the license
agreement is respected. Thank you very much!

About Battery Manager
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To view detailed information about the internal state of the Battery Manager software you can
activate the About Battery Manager menu which opens the dialog described here.
Alternatively, this status dialog can be displayed using the corresponding tool bar icon. This
dialog provides various tabs with detailed information about the current program, the Java
runtime environment as well as the operating system. Some of the tabs can be refreshed by
clicking the Refresh button. The Updates tab can also be called directly with a dedicated menu
item, please refer to the section Check for Updates.

• About: Symbol and info about license, Java environment, and program version

• Updates: Access to information about newer program versions

• Application: Characteristics about the running program and the computer

• Encodings: System charsets e.g. for the -logenc command-line argument

• Look & Feels: Info about the available look & feels

• Arguments: Command-line arguments the software has been started with

The Application tab lists the main internal parameters of the running application. These include
the computer name, the installed printers, the IP address of the computer, the presence of an
Internet connection, the local configuration directory within the user's home directory, the
license file, the log file as well as many other details, which can be useful when contacting the
Leisenfels support. If the individual values are not readable, then you can adjust the column
widths by moving the boundary line between the header cells accordingly.
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The Arguments tab displays the command-line parameters supported by the current
application version. Below the text area you can see the parameters actually in use.

Additional Links

• Premium Support

• Tool Bar
• Shortcuts
• Preferences

Preferences

• Files

• File Types
• Download
• Docking Windows

• File System Window

• Network File System Window

• Session Window

• Document Window

• Devices & Batteries

• Dialogs

• Disabled Dialogs

• Drag & Drop

• Miscellaneous

• Support

• Energy Saving

• Printing

The dialog for the preferences of the Battery Manager software shows an overview of the
supported units on the left side. The viewing mode may be set to either Options Tree or
Symbol List (see figure). Both the symbols and tree nodes are clickable, the settings of the
selected units are presented on the right side of the dialog.

By clicking the Cancel button, the current changes may be rejected. You can enter a search
pattern in the input field to search for. The matching units are then displayed on the left side, the
matches are highlighted on the right side to be easily identified. The search can be stopped with
the red X button, then all units are being shown again.
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With the arrow buttons above the list you can expand or collapse the tree (tree mode only).
These functions can be called also from the context menu of the units (right mouse button).
Here you can find the additional menues Restore Unit Defaults and Restore All Units, if you
like to reset the settings for a single or multiple units.

When option units are reset your pending changes will be lost. Please backup your
preferences prior to resetting, you can use the export preferences function to achieve
this. Backups may be imported again with the import preferences function.

The preferences can be displayed also with shortcuts (Windows/Mac) or from the tool bar by
clicking a button.

Files

• Version: The header text for created OpenPGP files, leave emty otherwise

• Use default icons and types: Display network files with default icons (faster)

• Use local icons and types (costly): Display network files like local files

Here you can find the settings for processing files with the program. If OpenPGP files are
written, the header may contain a single-line text (Version, optional). This text is arbitrary and
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may contain information like copyrights or your name or your company's name. The signature
files headers created by the generate window are not influenced by this option.

The options Use default icons and types is used to display network files which are listed for
instance by the network filesystem window. Here, a file symbol and the file type is being
displayed where this pieces of information are provided by the underlying operating system (see
file system window). It is not possible for network files so that either default symbols (document)
and default types (file, folder etc.) may be shown or as an alternative you may choose the Use
local icons and types (costly) option. Here, a temporary local file is created in order to
determine the network file type. This may be very costly and may slow down the program's
speed significantly. This effect may be reduced a little if a fast cache is used where previously
determined file symbols and types may be used again. Please activate the Use fast cache
option for this.

File Types

Several file types are already supported by the software. Graphics files in the formats PNG and
GIF may be displayed within the document window, XML files may also be edited there etc. The
list shows the configured file types with the associated file extensions. If selected then the input
field above may be used to edit the extensions. Multiple extensions must be separated with
space characters in order to support arbitrary extensions. Changes are being displayed
immediately by the list.

You can configure for each file extension how the type should be determined by the program.
Normally the option Simple extensions should be sufficient which means that the file types
must end with one of the configured extensions. For example the files test.zip, test.ZIP,
test.Zip are recognized with a configured zip extension. If the case of writing (lower/upper)
should matter then please choose the Case sensitive option.

Regular expressions are much more flexible and also file names beginning with a number or
special characters may be recognized. Please choose the Regular expression option for this.
You'll find the details on how regular expressions are used in section Regular Expressions.

For some of the listed extensions it can be configured how files should be opened or edited
(Open and Edit). This is always possible if the program has an internal feature implemented to
view the contained data (document window). You may choose for open or edit action separately
if it is executed by the Application or by the System (operating system).

Please keep in mind that the system execution depends heavily on the used operating system
and it may show no reaction at all. Under Window operating systems for example the WordPad
is opened if this program has been configured as the default viewer for the selected file.
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Download

Here you can setup the download options of the program like the download directory:

• Application download directory: subdirectory of the configuration directory

• Fixed directory: Always use the same directory

• Ask me before a resource is downloaded: Ask with dialog

Within the configuration directory of the program (like .battman-1.6.x) which is always located
in the user's home directory, a special directory is being created for downloads. Here all
downloads of the Battery Manager software may be downloaded (Application download
directory). If you like to use a different directory please select the Fixed directory option and
click the button with the dots in order to choose a directory. If you like to decide from file to file
please select the Ask me before a resource is downloaded option.

Downloads can be limited to a certain extent:

• Maximum number of files to download
• Maximum amount of data to download

The Maximum number of files to download option controls how many files are allowed to be
downloaded. This option helps to avoid unnecessary program errors (e.g. due to a
large memory consumption). If it becomes clear right before the download that too many files
are going to be processed then the GUI version of the program shows a dialog window where
you must explicitely confirm to continue. The command-line version of the software will abort at
an early stage. Please enter a plausible numeric value into the field (default is 100 files).

Like the number of files also the amount of processed data may be limited. The total size of the
processed files is calculated and compared with the value Maximum amount of data to
download. If the maximum amount of data is exceeded, then the GUI version of the program
shows a dialog window where you must explicitely confirm to continue. The command-line
version of the software will abort at an early stage.

Please enter a plausible numeric value into the field (default is 1G = 1 gigabyte). You may can
use the commonly used abbreviations (K)ilobytes, (M)egabytes, (G)igabytes and (T)erabytes
here, where a postive number must be specified in the first place. Faulty input is highlighted
here.

Docking Windows

The docking windows of the Battery Manager software are the central components of the
program and allow for several options to be configured here:
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• Enable ESCAPE to hide windows: Fast hide

• Move window to dock and show: Show window after close

• Move window to dock and hide: Hide window after close

• Close window completely: Disable window after close

• Automatically iconify separate windows: Minimize windows together

• Automatically deiconify (restore) separate windows: Restore windows together

Docking windows may be shown/hidden using either the dock button or the separate window
decoration. If a window must be hidden quickly without grabbing the mouse (for example
because other persons could read critical data) then the ESCAPE button can be configured for
this (option Enable ESCAPE to hide windows).

Some docking windows are often displayed in separate windows (e.g. the device window). If
such a window is being closed different kinds of behavior are possible which may be configured
here. In the normal case the window is moved back to the dock in order to show it again at the
new place (active window, option Move window to dock and show). A slightly different
behavior is the option Move window to dock and hide where the window is not displayed by
the dock afterwards. The variant Close window completely finally does not move to the dock
but disabled the windows completely. It may be restored at any time with the menu Window ->
Docking Windows.

If separate windows exist you can control the behavior here slighty. If the main window is being
minimized then also the separate windows can be minimized, too (Automatically iconify
separate windows) so that all program windows are in the same state. If the main window is
being restored (displayed on the screen again) then also the separate windows can be restored.
Please select the Automatically deiconify (restore) separate windows option here.

File System Window

This unit provides settings for the file system window:

• Root directory: View local main directory initially

• User's home directory: View user's home directory initially

• Restore previous directory: View previous directory initially

• Fixed directory: Always view a fixed directory initially

If the program gets started or the file system window is opened then it shows an initial directory
which you can configure here. The Root directory is determined by the underlying operating
system, under UNIX this directory is the root /. The User's home directory is determined by
the underlying operating system, too, under UNIX this is /home/bobby for example.
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If you work frequently with the file system window and it is useful to always start with the
previous settings again, then please choose the Restore previous directory option. If you like
to use a different directory instead, then the option Fixed directory is your friend. You can
choose a directory with the button with the dots.

Network File System Window

Provides the settings of the network file system window:

• No connections: Start without any sessions/connections

• Restore previous connections: Start with previous sessions/connections

If the program gets started or the network file system window is opened with the menu then it
shows an initial set of sessions each listing the files and directories. You can configure this
behaviour here.

If you like to start with an empty network file system window then choose the No connections
option. If you work frequently with the network file system window and it is useful to always start
with the previous settings again, then please choose the Restore previous sessions option.

Please keep in mind that all required connection parameters like user names and passwords
must be present in order to successfully reestablish previous sessions. If the password has not
been stored the last time then it must be entered now again. Please select the Display settings
before connection is established option in Edit Connections. You will be prompted to enter
your credentials if the connection is going to be established.

Please keep in mind that the network functionality is not supported by the Personal
Edition.

Session Window

Provides the settings of the session window:

• No connections: Start without any sessions/connections

• Restore previous connections: Start with previous sessions/connections

If the program gets started or the session window is opened with the menu then it shows an
initial set of database connections. You can configure this behaviour here.

If you like to start with an empty session window then choose the No connections option. If
you work frequently with the session window and it is useful to always start with the previous
settings again, then please choose the Restore previous sessions option.

Battery Manager 1.6.3 User Manual - Session Window

99 / 130



Please keep in mind that all required connection parameters like user names and passwords
must be present in order to successfully reestablish previous sessions. If the password has not
been stored the last time then it must be entered now again. Please select the Display settings
before connection is established option in Edit Connections. You will be prompted to enter
your credentials if the connection is going to be established.

Document Window

Shows the configuration options of the document window:

• No documents: Start without any documents

• Restore previous documents: Start with previous documents

• Ask me what to do with changed files: Show dialog

• Save changed files automatically when closed
• Close changed files without saving (changes are lost)
• Maximum number of files to open/edit
• Maximum file size to open/edit

If the program gets started ot the document window is opened using the menu then it starts
showing local or network resources. Which documents are automatically loaded can be
configured here.

If you like to start with an empty document window please choose the No documents option. If
you work frequently with the document window and it is useful to always start with the previous
settings again, then please choose the Restore previous documents option. Please
remember that the resources must still exist and must be accessible in order to be restored
(e.g. the network connection must be available).

When a document or the document window ot the whole application are closed then the
question is how to proceed with pending document changes. The option Ask me what to do
with changed files shows a dialog where you can choose on how to continue (save or reject).
The option Save changed files automatically when closed allows one to automatically save
changes when a document becomes closed. In order to reject changes by default please
choose the Close changed files without saving (changes are lost) option.

When edited documents are closed without saving your pending changes will be lost
and may not be restored with the program.

The Maximum number of files to open/edit option controls how many files are allowed to be
opened or edited. This option helps to avoid unnecessary program errors (e.g. due to a
large memory consumption). If it becomes clear right that too many files are going to be
processed then the GUI version of the program shows a dialog window where you must
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explicitely confirm to continue. The command-line version of the software will abort at an early
stage. Please enter a plausible numeric value into the field (default is 25 files).

Like the number of files also the amount of opened data may be limited. The size of the files is
compared with the value Maximum file size to open/edit before a file is opened. If the
maximum file size is exceeded, then the GUI version of the program shows a dialog window
where you must explicitely confirm to continue.

Please enter a plausible numeric value into the field (default is 10M = 10 megabyte). You may
can use the commonly used abbreviations (K)ilobytes, (M)egabytes, (G)igabytes and
(T)erabytes here, where a postive number must be specified in the first place. Faulty input is
highlighted here.

Devices & Batteries

Presents the settings of the device window:

• Switch to file logging at n samples

The device window supports logging measurement data from charging devices into the
database. It may happen that the database connection is lost during logging. In order to avoid
data loss in such cases the Battery Manager caches the datasets in the main memory first. If
man datasets have been stored this way the program has to switch to file file logging at some
point so that the application continues working properly.

The number of measurements to switch to file logging after connection losses may be
configured here. The slider may be set to values between 0 (start file logging immediately) and
10,000 samples. A reasonable value depends heavily on the interval used by the device
window for logging.

Dialogs

This unit provides the following dialog options:

• Java style (default): Display file choosers independently from OS

• Operating system style (native): Display file choosers like OS

• Auto-close timeout x milliseconds: Used by task dialog

If tasks like file downloads or digest checks are processed the task dialog is presented by the
application by default. Here you can find the messages of the program, the progress etc. If a
task has been successfully finished and the Close when finished flag has been selected then
the dialog automatically disappears after a certain period of time. Please enter a plausible

Battery Manager 1.6.3 User Manual - Session Window

101 / 130



numeric value into the Auto-close timeout x milliseconds field (default is 1500 milliseconds =
1.5 seconds). Faulty input is highlighted here.

Disabled Dialogs

Here, dialogs can be reactivated (shown again) which have been disabled before. Many of the
program dialogs provide support for the Do not show again flag on the left side (text may
vary), if the dialog should not be displayed again. This is useful for dialogs that appear again
and again showing well-known messages after input errors or due to special program states.

The list shows the dialog type, the description, and the current state of the dialog
(enabled/disabled). If the Do not show again flag has been selected for a dialog then the flag
in the Enabled column is not selected here. You may reactivate disabled dialogs by setting the
Enabled flag so that the dialog will be shown again the next time.

If you like to enabled or disable all dialogs at once please click on the Enable All or Disable All
buttons.

Drag & Drop

Files and directories may be easily exchanged between the file system window, the network file
system window and other docking windows. Here you can configure which drag & drop actions
are allowed. Currently the Battery Manager supports dragging files from the file system and
network file system window.

• File system window drag
• Network file system window drag

The list shows the drag & drop type, the description, and the current state of the action
(enabled/disabled). You may reactivate disabled drag & drop actions by setting the Enabled
flag so that the action is possible again.

If the drag & drop turns out to be not useful for your daily work you may disable drag & drop
completely with the Enable Drag & Drop flag at the top. If you like to enabled or disable all
actions at once please click on the Enable All or Disable All buttons.

Miscellaneous

Here you can find the settings that do not fit into the other categories:

• Show controller at x %: Memory controller in status bar is shown for threshold value

• Detect and unlock hanging GUI after x seconds
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• Scale fonts: Set zoom factor for program texts, 100% = default size

• Data Lists: Show top of list or restore previous scroll position

• Logging: Adjust log level (output)

Typically the memory controller is displayed if a certain threshold value is reached (default:
75%). Then memory should be released, dialogs should be closed, or the available memory
size should be increased by settings a parameter. For extremely high memory consumption
near 100% the application should be terminated in order to avoid data loss. Please enter the
value 0 here to always display the memory controller, the value 100 never displays this
component.

The program may "hang" in certain situations, the GUI does not respond here. You can easily
detect such a state with a look at the integrated digital watch. During a hang the time value is
not being updated and the value remains. This behavior may be triggered for example if
network connections break down or if the program waits for network drives. Many hang
situations may be properly detected and unlocked successfully so that working with the program
is possible again.

Please enter a plausible numeric value into the Detect and unlock hanging GUI after x
seconds field (default is 15 seconds). Faulty input is highlighted here. If selected the program
creates a dialog in such situations. Customers with Premium Support option may send a status
report for the error to be analyzed by the Leisenfels support.

Please enter a plausible numeric value into the Scale fonts field (default is 100%). Faulty input
is highlighted here. You can use e.g. 125% in order to display larger fonts or e.g. 80% in order
to decrease the font size. You can calibrate the font size also with the Fonts menu or with the
keyboard shortcuts.

In Data Lists you can configure if updated lists should display the top entry or if the previous
scroll position should be restored (default). In the Logging area the current program log level
may be adjusted. This option controls which log messages are being generated: OFF turns
logging completely off, ALL generates all possible messages. The log messages are directly
displayed by the output window. The log level is primarily controlled by a command line
argument so changing this setting takes effect for the current runtime of the program only. The
next time the software is started your changes will be reset to the value specified as command
line argument.

Caution: The finer log levels may produce a lot of messages! The levels

FINE/FINER/FINEST/ALL should be handled with care.

Support
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Here you can configure how status reports are being collected. The list shows the available
categories for the status report, the description, as well as the current state, whether the
category is to be transferred or not (Enabled column). You can reactivate disabled categories
by selecting the flag in the Enabled column so that data portions of that category are being
collected again. If you like to enabled or disable all categories in the list at once please click on
the Enable All or Disable All buttons.

Currently the following types of data can be transmitted within a status report:

• Messages: Messages of the program or own remarks as text

• Attachments: Resources of the program or own additional files

• License Info: Characteristics about the current license

• Log Files: File with messages of the program for error analysis

• Status Info: General information about the running program

• Screen Shots: Photos of the program windows and the whole screen

The status report functionality currently is reserved for customers with
Premium Support option.

Energy Saving

This section contains the functions to save energy (auto-off). If long running tasks are being
executed by the application like the search for files then the program may be configured so that
the computer is turned off after all tasks have finished. This makes sense for tasks which are
started before closing time and that take some time to finish unattendedly. It would be a waste
of energy to keep the computer running the whole night through.

• Standby Command: System command to move the computer to standby mode

• Log Off Command: System command to log the user off the computer

• Reboot Command: System command to restart the computer

• Shutdown Command: System command to turn the computer off completely

• Allow auto-off be cancelled within n seconds

The commands to be configured here are deposited as far as possible. For single operating
systems it may be necessary to adjust the commands for specialties (like being run as
administrator). For the standby mode the Exit option can be set so that the program is
terminated before the computer goes to standby mode.

In order to prevent from accidentally auto-off the program shows a dialog right before the
auto-off where the action can be cancelled for a certain period of time. This time to wait in
seconds may be adjusted here.
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The auto-off function can be started by using the button found in the status bar of the program
once tasks are executed in the background.

Printing

Printing can be controlled here in some ways:

• Paper size
• Scale factor
• Default printer
• Show printing preview
• Open PDF documents after export

Currently Letter and DIN A4 may be set as paper size. The scale factor determines the
printing size (default: 100%). Based on the printer an appripriate value can be set here to
optimize the printing results. If a default printer is set the program never asks for a printer to
use and printing is always done using this printer.

By default the program displays a preview before printing. If this is not desired the Show
printing preview can be deselected. If PDF documents generated by the printing preview shall
be opened automatically please set the Open PDF documents after export option.

Additional Links

• Export Preferences
• Import Preferences
• Save Preferences
• Tool Bar
• Shortcuts
• Network File System Window

• File System Window

• Regular Expressions

• Document Window

• Docking Window

• Device Window

• Edit Connections (network)

• Edit Connections (database)

• Premium Support

• Send Status Report
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Tool Bar

The tool bar is located between the main menu and the docking window area of the main
window. There you can find several functions of the main menu which are represented by
graphical symbols. Optionally the tool bar displays labels for the buttons. Buttons and labels
may be clicked directly in order to call the associated function. Some of the functions are
context-sensitive which means they may be disabled depending on the active docking window
or program state and may not be clicked then.

The labels below the buttons may be hidden or shown with the context menu of the tool bar
(right mouse button). If you like the tool bar not being displayed at all then you could configure
this with the main menu Setup -> View -> Tool Bar.

Currently the tool bar provides the following functions:

• Save: Save current document in document window

• Cut: Delete files/directories, list entries etc.

• Copy: Copy text, files, or network files in clipboard depending on the context

• Paste: Paste contents from clipboard (texts, files etc.)

• Delete: Delete files/directories, list entries etc.

• Find: Search for files/network files, search documents etc.

• Preferences: Edit the program preferences

• Connections (database): Start the database connection management

• New Session (database) : Open a new connection tab in the session window

• Connect: Connect to the database e.g. after connection loss

• Disconnect: Disconnect from the database currently active in the session window

• Connections (network): Start the network connection management

• New Session (network): Open a new session tab in the network file system window

• Refresh: Update lists, directories etc. depending on the context

• Help: Open the help system at a certain page (context-sensitive)

Many of the functions can also be called with shortcuts (Windows/Mac).

Additional Links

• Main Window

• Document Window
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• Preferences

• Session Window

• Network File System Window

• Shortcuts

Status Bar

You can find the status bar at the bottom of the main window.

This is the place where messages of the program are displayed on the left. Depending on the
type of issue the message symbols vary, thus simple hints and critical warnings can be easily
distinguished.

To the right of the message area you can see several icon buttons for the embedded database
(start/stop), the energy saving functions, to release the clipboard, and to collect garbage. The
memory controller right next to it serves to control the current memory usage of the program.
When generating very many message digests e.g. for all system drives, memory usage can
grow very rapidly so that the calculation can not be executed. Based on the memory controller
display this can be easily detected and the memory size for the program can then be adjusted
directly from the software. Please use the Setup -> Memory -> Memory Size menu to do this.

The software starts with a maximum memory size of 256 megabytes, although this size does
not exactly correspond with the actual memory size of the program at the level of the operating
system which is shown for example by the Windows Task Manager. In the preferences one can
configure if and at which threshold value the memory controller is displayed automatically.

Far right in the status bar there is a digital clock arranged displaying the current date when
passing with the mouse.

If you like the status bar not being displayed at all then you can configure this with the Setup ->
View -> Status Bar menu item. Alternatively you can use the context menu (right mouse
button) to show or hide the status bar (see figure). The memory controller and digital clock each
have an own context menu (right mouse button) where you can control these components
separately so that the status bar can be easily customized.

Some of the functions can also be called with shortcuts (Windows/Mac).

Additional Links
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• Main Window

• Preferences

• Shortcuts

Shortcuts

Here you can find an overview of the implemented keyboard shortcuts for the Battery Manager
software main window to be used alternatively for the various menu items. The listed shortcuts
are recommended for experienced users.

In Mac OS X the default modifier key is the Command key (Cmd). Mac users have to use the
Command key instead of the Control modifier key (Ctrl) as shown by the table.
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Nr. Shortcut Win Shortcut Mac Menu Description

1 Ctrl+E Cmd+E File -> Edit Files Open file(s) in document
window

2 Ctrl+S Cmd+S File -> Save Save currently edited file

3 Ctrl+Alt+S Cmd+Alt+S File -> Save Preferences Save current preferences
explicitely

4 Ctrl+P Cmd+P File -> Print Print (e.g. current
database table)

5 Ctrl+Q Cmd+Q File -> Exit Quit the Battery Manager
software

6 Ctrl+X Cmd+X Edit -> Cut Delete texts/files

7 Ctrl+C Cmd+C Edit -> Copy Copy texts/files to
clipboard

8 Ctrl+V Cmd+V Edit -> Paste Insert texts/files from
clipboard

9 Delete Delete Edit -> Delete Delete files

10 Ctrl+F Cmd+F Edit -> Find Search for files

11 Ctrl+Plus Cmd+Plus Setup -> Fonts
-> Larger Fonts

Show slightly larger fonts

12 Ctrl+Minus Cmd+Minus Setup -> Fonts
-> Smaller Fonts

Show slightly smaller
fonts

13 Ctrl+G Cmd+G Setup -> Memory
-> Collect Garbage

Make RAM available
again

14 Alt+S Alt+S Setup -> Preferences Open the preferences
dialog

15 Ctrl+D Cmd+D Devices -> Edit Devices Starts the device

management
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16 Alt+P Alt+P Devices -> Rescan Ports Detect serial ports for
computer

17 Ctrl+Alt+C Cmd+Alt+C Window -> Screen Shot
-> Capture Tool

Take screen shots of the
running application

18 Ctrl+F4 Cmd+F4 Window -> Close Tab Close the active tab

19 Escape Escape Window -> Hide Hide the active docking
window

20 F5 F5 Window -> Refresh Update the active
docking window

21 F1 F1 Help -> Help
(context-sensitive)

Open the help system
dialog
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Third Party Components

The Battery Manager software is based on many components from other manufacturers which
are listed here as far as this is due to the licensing conditions. The installer-based deployments
of the Battery Manager software contain the files with the detailed license texts. You can find
these license files in the license subdirectory of the installation directory on your computer.

• Alloy Look&Feel

• Apache Commons Codec

• Apache Derby

• Apache HttpComponents Client

• Apache HttpComponents Core

• Apache Commons Logging

• Apache Commons Net

• Apache Jakarta Commons VFS

• AppleJavaExtensions

• AWS SDK for Java

• Barbecue

• Bouncy Castle

• Dropbox SDK

• Google Annotations JSR305

• Google Drive API

• HexEditor

• Install4j Multi-Platform Edition

• Jackson JSON Processor

• JasperReports

• Java API for Servlets

• JavaMail

• Java Runtime Environment

• JavaHelp

• Jaxen

• JDOM

• JGoodies Forms

• JSch

• jSSC (Java Simple Serial Connector)

• JTattoo

• MySQL Connector/J

• OpenPGP Library for Java

• Oracle JDBC Driver

• RSyntaxTextArea

• TableLayout
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The Web Start installations include the license texts not as locally installed files, but the license
texts can be downloaded as a compressed ZIP archive from the Leisenfels Internet server. If
the Battery Manager software has been installed via Web Start for example by using the
following link (the address may vary), so the ZIP archive named 3rdparty.zip can be
downloaded as shown (just enter the address in your Web browser, an Internet connection is
required):

Installation: http://jws.leisenfels.com:8080/battman-1.6.x/install.jnlp

ZIP archive: http://jws.leisenfels.com:8080/battman-1.6.x/license/3rdparty.zip

The Battery Manager software is shipped with the following components developed by other
manufacturers. Besides the copyright information and the name of the license text file you can
find additional remarks, if this is part of the licensing conditions. The websites of the respective
licensors are listed if known at the time of writing of this documentation.

Alloy Look&Feel

Copyright © INCORS GmbH

http://www.incors.com

alloy_license.txt

Apache Commons Codec

Copyright © The Apache Software Foundation

http://www.apache.org

apache_license.txt

Apache Derby

Copyright © 2004-2012 The Apache Software Foundation

http://www.apache.org
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apache_license.txt, apache_notice_derby.txt

=========================================================================
== NOTICE file corresponding to section 4(d) of the Apache License,
== Version 2.0, in this case for the Apache Derby distribution.
==
== DO NOT EDIT THIS FILE DIRECTLY. IT IS GENERATED
== BY THE buildnotice TARGET IN THE TOP LEVEL build.xml FILE.
==
=========================================================================
Apache Derby
Copyright 2004-2012 The Apache Software Foundation
This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).
=========================================================================
Portions of Derby were originally developed by
International Business Machines Corporation and are
licensed to the Apache Software Foundation under the
"Software Grant and Corporate Contribution License Agreement",
informally known as the "Derby CLA".
The following copyright notice(s) were affixed to portions of the code
with which this file is now or was at one time distributed
and are placed here unaltered.
(C) Copyright 1997,2004 International Business Machines Corporation. All rights reserved.
(C) Copyright IBM Corp. 2003.
=========================================================================
The portion of the functionTests under 'nist' was originally
developed by the National Institute of Standards and Technology (NIST),
an agency of the United States Department of Commerce, and adapted by
International Business Machines Corporation in accordance with the NIST
Software Acknowledgment and Redistribution document at
http://www.itl.nist.gov/div897/ctg/sql_form.htm
=========================================================================
The JDBC apis for small devices and JDBC3 (under java/stubs/jsr169 and
java/stubs/jdbc3) were produced by trimming sources supplied by the
Apache Harmony project. In addition, the Harmony SerialBlob and
SerialClob implementations are used. The following notice covers the Harmony sources:
Portions of Harmony were originally developed by
Intel Corporation and are licensed to the Apache Software
Foundation under the "Software Grant and Corporate Contribution
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License Agreement", informally known as the "Intel Harmony CLA".
=========================================================================
The Derby build relies on source files supplied by the Apache Felix
project. The following notice covers the Felix files:
Apache Felix Main
Copyright 2008 The Apache Software Foundation
I. Included Software
This product includes software developed at
The Apache Software Foundation (http://www.apache.org/).
Licensed under the Apache License 2.0.
This product includes software developed at
The OSGi Alliance (http://www.osgi.org/).
Copyright (c) OSGi Alliance (2000, 2007).
Licensed under the Apache License 2.0.
This product includes software from http://kxml.sourceforge.net.
Copyright (c) 2002,2003, Stefan Haustein, Oberhausen, Rhld., Germany.
Licensed under BSD License.
II. Used Software
This product uses software developed at
The OSGi Alliance (http://www.osgi.org/).
Copyright (c) OSGi Alliance (2000, 2007).
Licensed under the Apache License 2.0.
III. License Summary
- Apache License 2.0
- BSD License
=========================================================================
The Derby build relies on jar files supplied by the Apache Xalan
project. The following notice covers the Xalan jar files:
=========================================================================
== NOTICE file corresponding to section 4(d) of the Apache License, ==
== Version 2.0, in this case for the Apache Xalan Java distribution. ==
=========================================================================
Apache Xalan (Xalan XSLT processor)
Copyright 1999-2006 The Apache Software Foundation
Apache Xalan (Xalan serializer)
Copyright 1999-2006 The Apache Software Foundation
This product includes software developed at
The Apache Software Foundation (http://www.apache.org/).
=========================================================================
Portions of this software was originally based on the following:
- software copyright (c) 1999-2002, Lotus Development Corporation.,
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http://www.lotus.com.
- software copyright (c) 2001-2002, Sun Microsystems.,
http://www.sun.com.
- software copyright (c) 2003, IBM Corporation.,
http://www.ibm.com.
=========================================================================
The binary distribution package (ie. jars, samples and documentation) of
this product includes software developed by the following:
- The Apache Software Foundation
- Xerces Java - see LICENSE.txt
- JAXP 1.3 APIs - see LICENSE.txt
- Bytecode Engineering Library - see LICENSE.txt
- Regular Expression - see LICENSE.txt
- Scott Hudson, Frank Flannery, C. Scott Ananian
- CUP Parser Generator runtime (javacup\runtime) - see LICENSE.txt
=========================================================================
The source distribution package (ie. all source and tools required to build
Xalan Java) of this product includes software developed by the following:
- The Apache Software Foundation
- Xerces Java - see LICENSE.txt
- JAXP 1.3 APIs - see LICENSE.txt
- Bytecode Engineering Library - see LICENSE.txt
- Regular Expression - see LICENSE.txt
- Ant - see LICENSE.txt
- Stylebook doc tool - see LICENSE.txt
- Elliot Joel Berk and C. Scott Ananian
- Lexical Analyzer Generator (JLex) - see LICENSE.txt
=========================================================================
Apache Xerces Java
Copyright 1999-2006 The Apache Software Foundation
This product includes software developed at
The Apache Software Foundation (http://www.apache.org/).
Portions of Apache Xerces Java in xercesImpl.jar and xml-apis.jar
were originally based on the following:
- software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
- software copyright (c) 1999, Sun Microsystems., http://www.sun.com.
- voluntary contributions made by Paul Eng on behalf of the
Apache Software Foundation that were originally developed at iClick, Inc.,
software copyright (c) 1999.
=========================================================================
Apache xml-commons xml-apis (redistribution of xml-apis.jar)
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Apache XML Commons
Copyright 2001-2003,2006 The Apache Software Foundation.
This product includes software developed at
The Apache Software Foundation (http://www.apache.org/).
Portions of this software were originally based on the following:
- software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
- software copyright (c) 1999, Sun Microsystems., http://www.sun.com.
- software copyright (c) 2000 World Wide Web Consortium, http://www.w3.org

Apache HttpComponents Client

Copyright © 1999-2012 The Apache Software Foundation

http://www.apache.org

apache_license.txt, apache_notice_httpcompclient.txt

Apache HttpComponents Client
Copyright 1999-2012 The Apache Software Foundation
This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Apache HttpComponents Core

Copyright © 2005-2012 The Apache Software Foundation

http://www.apache.org

apache_license.txt, apache_notice_httpcompcore.txt

Apache HttpComponents Core
Copyright 2005-2012 The Apache Software Foundation
This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).
This project contains annotations derived from JCIP-ANNOTATIONS
Copyright (c) 2005 Brian Goetz and Tim Peierls. See http://www.jcip.net

Apache Commons Logging
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Copyright © The Apache Software Foundation
http://www.apache.org

apache_license.txt, apache_notice_logging.txt

This product includes software developed by

The Apache Software Foundation (http://www.apache.org/).

Apache Commons Net

Copyright © 2001-2011 The Apache Software Foundation
http://www.apache.org

apache_license.txt, apache_notice_net.txt

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Apache Jakarta Commons VFS

Copyright © 2002-2011 The Apache Software Foundation
http://www.apache.org

apache_license.txt, apache_notice_vfs.txt

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

AppleJavaExtensions

Copyright © 2003-2010 Apple Inc.

http://www.apple.com

apple_license.txt

AWS SDK for Java
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Copyright © 2010-2012 Amazon.com, Inc. or its affiliates

http://www.amazon.com

amazon_s3_license.txt, amazon_s3_notice.txt

AWS SDK for Java
Copyright 2010-2012 Amazon.com, Inc. or its affiliates. All Rights Reserved.
This product includes software developed by
Amazon Technologies, Inc (http://www.amazon.com/).
**********************
THIRD PARTY COMPONENTS
**********************
This software includes third party software subject to the following copyrights:
- XML parsing and utility functions from JetS3t - Copyright 2006-2009 James Murty.
- JSON parsing and utility functions from JSON.org - Copyright 2002 JSON.org.
The licenses for these third party components are included in LICENSE.txt

Barbecue

Copyright © 2003, International Barcode Consortium

http://barbecue.sourceforge.net

barbecue_license.txt

Bouncy Castle

Copyright © 2000-2008 The Legion Of The Bouncy Castle

http://www.bouncycastle.org

bouncycastle_license.txt

Dropbox SDK

Copyright © 2013 Dropbox Inc.

http://www.dropbox.com
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dropbox_license.txt

Google Annotations JSR305

Copyright (c) 2012, William Pugh

https://developers.google.com/drive

jsr305_license.txt

Google Drive API

Copyright © 2013 Google Inc.

https://developers.google.com/drive

google_drive_license.txt

HexEditor

Copyright © 2008 Robert Futrell

http://fifesoft.com/hexeditor

hexeditor_license.txt

Install4j Multi-Platform Edition

Copyright © 2001-2010 ej-technologies GmbH

http://www.ej-technologies.com

install4j_license.txt

Jackson JSON Processor

Copyright © 2009-2011 FasterXML, LLC.

http://www.fasterxml.com
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jackson_license.txt

JasperReports

Copyright © 2001-2006 JasperSoft Corporation

http://www.jaspersoft.com

jasperreports_license.txt

Java API for Servlets

Copyright © The Apache Software Foundation

http://www.apache.org

apache_license.txt, apache_notice_tomcat.txt

This product includes software developed by

The Apache Software Foundation (http://www.apache.org/).

Java Management Extensions (JMX) support is provided by

the MX4J package, which is open source software. The

original software and related information is available

at http://mx4j.sourceforge.net.

The Windows Installer is built with the Nullsoft

Scriptable Install Sysem (NSIS), which is

open source software. The original software and

related information is available at

http://nsis.sourceforge.net.

Java compilation software for JSP pages is provided by Eclipse,
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which is open source software. The orginal software and

related infomation is available at

http://www.eclipse.org.

JavaMail

Copyright © Oracle Corporation
http://www.oracle.com

javamail_license.txt

Java Runtime Environment

Copyright © 2006, 2012, Oracle and/or its affiliates
http://www.oracle.com

java_license.txt

JavaHelp

Copyright © Sun Microsystems, Inc.

http://java.sun.com

javahelp_license.html

Jaxen

Copyright © 2003-2006 The Werken Company

http://jaxen.codehaus.org

jaxen_license.txt

JDOM
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Copyright © 2000-2004 Jason Hunter & Brett McLaughlin

http://www.jdom.org

jdom_license.txt

This product includes software developed by the

JDOM Project (http://www.jdom.org/).

JGoodies Forms

Copyright © 2001-2007 JGoodies Karsten Lentzsch

http://www.jgoodies.com

jgoodies_license.txt

JSch

Copyright © 2002,2003,2004,2005,2006 Atsuhiko Yamanaka, JCraft,Inc.

http://www.jcraft.com/

jsch_license.txt

jSSC (Java Simple Serial Connector)

Copyright © 2010-2013 Alexey Sokolov (scream3r)

http://code.google.com/p/java-simple-serial-connector/

jssc_license.txt

JTattoo

Copyright © 2002-2007 MH Software-Entwicklung

http://www.jtattoo.de
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jtattoo_license.txt

MySQL Connector/J

Copyright © 2003-2008 MySQL AB, 2008 Sun Microsystems

http://www.mysql.com

mysql_license.txt

OpenPGP Library for Java

Copyright © DidiSoft Ltd.

http://www.didisoft.com

pgplib_license.rtf

Oracle JDBC Driver

Copyright © Oracle Corporation

http://www.oracle.com

oracle_license.txt

RSyntaxTextArea

Copyright © 2012, Robert Futrell

http://fifesoft.com/rsyntaxtextarea

rsyntaxtextarea_license.txt

TableLayout

Copyright © 2001 Daniel Barbalace

https://tablelayout.dev.java.net
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tablelayout_license.txt

Regular Expressions

Regular expressions can be used to ignore certain files for example and are implemented by
the Java class java.util.regex.Pattern. This class is part of the Java environment by Oracle
since version 1.4. The following section is an extract of the API documentation (Javadoc) which
is currently onlyavailable in English. Copyright © 2003 Sun Microsystems, Inc. All
rights reserved.

Summary of regular-expression constructs
Construct Matches

Characters

x The character x

\\ The backslash character

\0n The character with octal value 0n (0 <= n <= 7)

\0nn The character with octal value 0nn (0 <= n <= 7)

\0mnn The character with octal value 0mnn (0 <= m <= 3, 0 <= n <= 7)

\xhh The character with hexadecimal value 0xhh

\uhhhh The character with hexadecimal value 0xhhhh

\t The tab character ('\u0009')

\n The newline (line feed) character ('\u000A')

\r The carriage-return character ('\u000D')

\f The form-feed character ('\u000C')

\a The alert (bell) character ('\u0007')

\e The escape character ('\u001B')

\cx The control character corresponding to x

Character classes

[abc] a, b, or c (simple class)

[^abc] Any character except a, b, or c (negation)

[a-zA-Z] a through z or A through Z, inclusive (range)

[a-d[m-p]] a through d, or m through p: [a-dm-p] (union)

[a-z&&[def]] d, e, or f (intersection)

[a-z&&[^bc]] a through z, except for b and c: [ad-z] (subtraction)

[a-z&&[^m-p]] a through z, and not m through p: [a-lq-z](subtraction)
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Predefined character classes

. Any character (may or may not match line terminators)

\d A digit: [0-9]

\D A non-digit: [^0-9]

\s A whitespace character: [ \t\n\x0B\f\r]

\S A non-whitespace character: [^\s]

\w A word character: [a-zA-Z_0-9]

\W A non-word character: [^\w]

POSIX character classes (US-ASCII only)

\p{Lower} A lower-case alphabetic character: [a-z]

\p{Upper} An upper-case alphabetic character:[A-Z]

\p{ASCII} All ASCII:[\x00-\x7F]

\p{Alpha} An alphabetic character:[\p{Lower}\p{Upper}]

\p{Digit} A decimal digit: [0-9]

\p{Alnum} An alphanumeric character:[\p{Alpha}\p{Digit}]

\p{Punct} Punctuation: One of !"#$%&'()*+,-./:;<=>?@[\]^_`{|}~

\p{Graph} A visible character: [\p{Alnum}\p{Punct}]

\p{Print} A printable character: [\p{Graph}]

\p{Blank} A space or a tab: [ \t]

\p{Cntrl} A control character: [\x00-\x1F\x7F]

\p{XDigit} A hexadecimal digit: [0-9a-fA-F]

\p{Space} A whitespace character: [ \t\n\x0B\f\r]

Classes for Unicode blocks and categories

\p{InGreek} A character in the Greek block (simple block)

\p{Lu} An uppercase letter (simple category)

\p{Sc} A currency symbol

\P{InGreek} Any character except one in the Greek block (negation)

[\p{L}&&[^\p{Lu}]] Any letter except an uppercase letter (subtraction)

Boundary matchers

^ The beginning of a line

$ The end of a line

\b A word boundary

\B A non-word boundary

\A The beginning of the input

\G The end of the previous match

\Z The end of the input but for the final terminator, if any
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\z The end of the input

Greedy quantifiers

X? X, once or not at all

X* X, zero or more times

X+ X, one or more times

X{n} X, exactly n times

X{n,} X, at least n times

X{n,m} X, at least n but not more than m times

Reluctant quantifiers

X?? X, once or not at all

X*? X, zero or more times

X+? X, one or more times

X{n}? X, exactly n times

X{n,}? X, at least n times

X{n,m}? X, at least n but not more than m times

Possessive quantifiers

X?+ X, once or not at all

X*+ X, zero or more times

X++ X, one or more times

X{n}+ X, exactly n times

X{n,}+ X, at least n times

X{n,m}+ X, at least n but not more than m times

Logical operators

XY X followed by Y

X|Y Either X or Y

(X) X, as a capturing group

Back references

\n Whatever the nth capturing group matched

Quotation

\ Nothing, but quotes the following character

\Q Nothing, but quotes all characters until \E

\E Nothing, but ends quoting started by \Q

Special constructs (non-capturing)

(?:X) X, as a non-capturing group

(?idmsux-idmsux) Nothing, but turns match flags on - off

(?idmsux-idmsux:X) X, as a non-capturing group with the given flags on - off
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(?=X) X, via zero-width positive lookahead

(?!X) X, via zero-width negative lookahead

(?<=X) X, via zero-width positive lookbehind

(?<!X) X, via zero-width negative lookbehind

(?>X) X, as an independent, non-capturing group

Backslashes, escapes, and quoting

The backslash character ('\') serves to introduce escaped constructs, as defined in the table
above, as well as to quote characters that otherwise would be interpreted as unescaped
constructs. Thus the expression \\ matches a single backslash and \{ matches a left brace.

It is an error to use a backslash prior to any alphabetic character that does not denote an
escaped construct; these are reserved for future extensions to the regular-expression language.
A backslash may be used prior to a non-alphabetic character regardless of whether that
character is part of an unescaped construct.

Backslashes within string literals in Java source code are interpreted as required by the Java
Language Specification as either Unicode escapes or other character escapes. It is therefore
necessary to double backslashes in string literals that represent regular expressions to protect
them from interpretation by the Java bytecode compiler. The string literal "\b", for example,
matches a single backspace character when interpreted as a regular expression, while "\\b"

matches a word boundary. The string literal "\(hello\)" is illegal and leads to a compile-time
error; in order to match the string (hello) the string literal "\\(hello\\)" must be used.

Character Classes

Character classes may appear within other character classes, and may be composed by the
union operator (implicit) and the intersection operator (&&). The union operator denotes a class
that contains every character that is in at least one of its operand classes. The intersection
operator denotes a class that contains every character that is in both of its operand classes.

The precedence of character-class operators is as follows, from highest to lowest:

1 Literal escape \x

2 Grouping [...]

3 Range a-z

4 Union [a-e][i-u]

5 Intersection [a-z&&[aeiou]]
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Note that a different set of metacharacters are in effect inside a character class than outside a
character class. For instance, the regular expression . loses its special meaning inside a
character class, while the expression - becomes a range forming metacharacter.

Line terminators

A line terminator is a one- or two-character sequence that marks the end of a line of the input
character sequence. The following are recognized as line terminators:

• A newline (line feed) character ('\n'),
• A carriage-return character followed immediately by a newline character ("\r\n"),
• A standalone carriage-return character ('\r'),
• A next-line character ('\u0085'),
• A line-separator character ('\u2028'), or
• A paragraph-separator character ('\u2029).

UNIX_LINES mode is activated, then the only line terminators recognized are newline
characters.

The regular expression . matches any character except a line terminator unless the DOTALL

flag is specified.

By default, the regular expressions ^ and $ ignore line terminators and only match at the
beginning and the end, respectively, of the entire input sequence. If MULTILINE mode is
activated then ^ matches at the beginning of input and after any line terminator except at the
end of input. When in MULTILINE mode $ matches just before a line terminator or the end of
the input sequence.

Groups and capturing

Capturing groups are numbered by counting their opening parentheses from left to right. In the
expression ((A)(B(C))), for example, there are four such groups:

1 ((A)(B(C)))

2 (A)

3 (B(C))

4 (C)

Group zero always stands for the entire expression.
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Capturing groups are so named because, during a match, each subsequence of the input
sequence that matches such a group is saved. The captured subsequence may be used later in
the expression, via a back reference, and may also be retrieved from the matcher once the
match operation is complete.

The captured input associated with a group is always the subsequence that the group most
recently matched. If a group is evaluated a second time because of quantification then its
previously-captured value, if any, will be retained if the second evaluation fails. Matching the
string "aba" against the expression (a(b)?)+, for example, leaves group two set to "b". All
captured input is discarded at the beginning of each match.

Groups beginning with (? are pure, non-capturing groups that do not capture text and do not
count towards the group total.

Unicode support

This class follows Unicode Technical Report #18: Unicode Regular Expression Guidelines,
implementing its second level of support though with a slightly different concrete syntax.

Unicode escape sequences such as \u2014 in Java source code are processed as described
in ?3.3 of the Java Language Specification. Such escape sequences are also implemented
directly by the regular-expression parser so that Unicode escapes can be used in expressions
that are read from files or from the keyboard. Thus the strings "\u2014" and "\\u2014",
while not equal, compile into the same pattern, which matches the character with hexadecimal
value 0x2014.

Unicode blocks and categories are written with the \p and \P constructs as in Perl. \p{prop}
matches if the input has the property prop, while \P{prop} does not match if the input has that
property. Blocks are specified with the prefix In, as in InMongolian. Categories may be
specified with the optional prefix Is: Both \p{L} and \p{IsL} denote the category of Unicode
letters. Blocks and categories can be used both inside and outside of a character class.

The supported blocks and categories are those of The Unicode Standard, Version 3.0. The
block names are those defined in Chapter 14 and in the file Blocks-3.txt of the Unicode
Character Database except that the spaces are removed; "Basic Latin", for example,
becomes "BasicLatin". The category names are those defined in table 4-5 of the Standard
(p. 88), both normative and informative.

Comparison to Perl 5

Perl constructs not supported by this class:
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• The conditional constructs (?{X}) and (?(condition)X|Y),

• The embedded code constructs (?{code}) and (??{code}),

• The embedded comment syntax (?#comment), and

• The preprocessing operations \l\u , \L, and \U.

Constructs supported by this class but not by Perl:

• Possessive quantifiers, which greedily match as much as they can and do not back off,
even when doing so would allow the overall match to succeed.

• Character-class union and intersection as described above.

Notable differences from Perl:

• In Perl, \1 through \9 are always interpreted as back references; a backslash-escaped
number greater than 9 is treated as a back reference if at least that many subexpressions
exist, otherwise it is interpreted, if possible, as an octal escape. In this class octal escapes
must always begin with a zero. In this class, \1 through \9 are always interpreted as back
references, and a larger number is accepted as a back reference if at least that many
subexpressions exist at that point in the regular expression, otherwise the parser will drop
digits until the number is smaller or equal to the existing number of groups or it is one digit.

• Perl uses the g flag to request a match that resumes where the last match left off. This
functionality is provided implicitly by the Matcher class: Repeated invocations of the find

method will resume where the last match left off, unless the matcher is reset.

• In Perl, embedded flags at the top level of an expression affect the whole expression. In
this class, embedded flags always take effect at the point at which they appear, whether
they are at the top level or within a group; in the latter case, flags are restored at the end of
the group just as in Perl.

• Perl is forgiving about malformed matching constructs, as in the expression *a, as well as
dangling brackets, as in the expression abc], and treats them as literals. This class also
accepts dangling brackets but is strict about dangling metacharacters like +, ? and *, and
will throw a PatternSyntaxException if it encounters them.

For a more precise description of the behavior of regular expression constructs, please see
Mastering Regular Expressions, 2nd Edition, Jeffrey E. F. Friedl, O'Reilly and Associates, 2002.

Battery Manager 1.6.3 User Manual - Regular Expressions

130 / 130


	Table of Contents
	Overview
	Main Window
	Editions

	Docking Windows
	Session Window
	File System Window
	Network File System Window
	Document Window
	Device Window
	Search Window
	Filter Window
	Output Window
	Task Window
	Search Results Window
	Update Log Window

	Main Menu and Components
	File Menu
	Edit Menu
	Setup Menu
	Devices Menu
	Database Menu
	Table Menu
	Network Menu
	Window Menu
	Help Menu
	Preferences
	Tool Bar
	Status Bar

	Appendix
	Shortcuts
	Third Party Components
	Regular Expressions


